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Chapter 10

Using the 
Media Page

The Media page is the primary interface for media import and clip 
organization in DaVinci Resolve. As of version 12, it’s also where all 
timelines that you edit in DaVinci Resolve or import from other applications 
are organized. Although timelines and clips are now saved in the same 
place, it’s central to the way DaVinci Resolve works that the source media 
used by a project is managed separately from your timelines. In this way, 
you can manage and update the clips used by timelines with ease, 
importing and reorganizing clips, switching between offline and online 
media, and troubleshooting any problems that occur. 

The Media page also contains much of the core functionality used for 
on-set workflows, as well as most of the functions that are used in the 
ingest, organization, and sound-syncing procedures corresponding to 
digital dailies workflows. 
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Understanding the Media Page 
User Interface
By default, the Media page is divided into five different areas, designed to make it easy to find, 
select, and work with media in your project.

Media page

Much of the functionality and most of the commands are found within the contextual menus that 
appear when you right-click clips in the Media Storage browser or Media Pool.

The Interface Toolbar

At the very top of the Media page is a toolbar with buttons that let you show and hide different 
parts of the user interface. These buttons are as follows, from left to right:

The Interface toolbar

 � Media Storage full/half height button: Lets you set the Media Storage browser to take 
up the full height of your display, if you need more area for browsing at the expense of 
a smaller Media Pool.

 � Media Storage: Lets you hide or show the Media Storage browser. Hiding the Media 
Storage browser creates more room for the Viewer.

 � Clone Tool: Shows or hides the Clone tool, used for cloning media from camera cards 
or hard drives.

 � Audio Panel: Hides or shows the Audio Panel.

 � Metadata: Hides or shows the Metadata Editor.

 � Capture: Switches the Viewer and Audio Panel to Capture Mode, exposing the controls 
necessary for cuing up a device-controllable deck, and batch recording from tape.

 � Audio Panel/Metadata Editor full/half height button: Lets you set the Audio Panel 
or Metadata Editor to take up the full height of your display, if you need more area for 
either of those functions.
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Showing Which Panel Has Focus
Whenever you click somewhere on the DaVinci Resolve interface using the pointer, or use a 
keyboard shortcut to “select” a particular panel (such as in the Edit page), you give that panel of 
the user interface “focus.” A panel with focus will capture specific keyboard shortcuts to do 
something within that panel, as opposed to doing something elsewhere in the interface. A 
highlight appears at the top edge to show you which panel has focus, so that you can keep 
track of which part of the current page is taking precedence, and you can switch focus as 
necessary to do what you need to do.

The Focus indicator shown at the top edge of the Media 
Pool, shown next to a Viewer that doesn’t have focus

The Media Storage Browser
The Media Storage browser lets you see all of the volumes connected to your workstation, 
browsing them for media that you want to preview and eventually import into your 
DaVinci Resolve project in one way or another. Whereas other applications rely on some sort of 
import dialog, DaVinci Resolve provides the Media page for doing complex media import tasks. 
To facilitate media import, the Media Storage browser is divided into two areas, the Volume List, 
and the Media Browser.

Media Storage browser with scrubbable clip view

Chapter – 10 Using the Media Page 234



Playing Media in the Media Storage Browser
You can select media in the Media Storage Browser to play directly in the Media page Viewer, 
without importing it, so long as it’s in a format that DaVinci Resolve supports. This is useful for 
previewing clips that you’re considering using in a project, but it’s also useful for quality control 
review sessions of media that you’ve exported from DaVinci Resolve. All clips that are played in 
the Media page Viewer are also output to video, if you have a supported Blackmagic output 
interface. Additionally, if you choose Workspace > Dual Screen > On, the second computer 
display is capable of displaying a set of video scopes on the Media page, which can help you 
QC a program you’re delivering.

Playing DCP and IMF Packages
It’s also possible to use the Media Storage Browser to select and play DCP and IMF packages 
that have been exported either using EasyDCP or using the native DCP/IMF export capabilities 
of DaVinci Resolve. Simply locate the package, select it, and play it in the Viewer like any other 
clip. It will be output to video and analyzed by the video scopes. 

DCP and IMF packages can also be imported from Media Storage to the Media Pool for various 
workflows. For more information, see Chapter 139, “Delivering DCP and IMF.”

The Media Storage Browser’s Volume List
At the left of the Media Storage browser is a list of all volumes that are currently available to 
your DaVinci Resolve workstation. It’s used to locate media that you want to import manually 
into your project. The list is divided into two vertical areas of volumes. At the top are the actual 
volumes on your workstation:

 � Scratch volumes: Indicated by a usage statistic to the right of the volume name that 
lists how full that volume is, these are disks that you’ve added to the Media Storage 
panel of the System Preferences window. The topmost of these scratch disks is used to 
store Gallery stills and cache files.

 � Available volumes: Indicated by disk icons, this is a list of all fixed, removable, 
and network volumes that are currently available to your workstation. When the 
“Automatically display attached local and network storage locations” checkbox is 
turned on in the Media Storage panel of the System Preferences, new volumes that are 
attached to your workstation should automatically appear in this list.

This is a hierarchical list; clicking the disclosure triangle to the left of any volume opens up an 
additional list of that volume’s subdirectories, with additional disclosure triangles next to each 
subdirectory. Using the Media Storage browser, you can drill down into as many subdirectories 
as you need to. 

Adding Volumes That Don’t Appear in This List
If you need to access a storage volume that doesn’t appear on this list, for example if you’re 
using the version of DaVinci Resolve that is available in the Apple App Store, then you can 
right-click anywhere in the background of the Volume list and choose “Add New Location” to 
open a dialog you can use to choose a volume you want to add.

If you’re using the Apple App Store version of DaVinci Resolve, auto-mounting of attached 
storage volumes is not enabled automatically. However, you can enable this in the Media 
Storage panel of the System Preferences. For more information, see the DaVinci Resolve 
Preferences section of Chapter 3, “System and User Preferences.”
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Media Storage Browser Favorites
Underneath this is the Favorites area. If there are special directories that you find yourself 
frequently accessing, you can add them to the Favorites in order to avoid having to traverse 
complex hierarchies in order to access the media you need. The Favorites can be easily 
customized and used.

Methods of organizing favorite file system locations in the Media Storage Browser:
 � To add a favorite: Right-click any folder in the Media Storage browser folder list, and 

choose “Add folder to favorites” from the contextual menu. The new favorite appears at 
the bottom of the Favorites area.

 � To open a favorite: Click any favorite to expose the contents of the corresponding 
directory in the Media Storage browser.

 � To remove a favorite: Right-click the favorite you want to remove, and choose “Remove 
folder from favorites” from the contextual menu.

The Media Storage Browser Area
Once you’ve selected a volume or subdirectory in the Media Storage browser, you can view its 
contents in List view or Thumbnail view to search through the media that’s available to you as 
you try to find what you need.

List View
In List view, the following columns are available for sorting media prior to importing it into the 
Media Pool:

 � File name: The name of a file.

 � Reel name: The reel name as it’s currently derived according to the Conform Options 
that are currently chosen in the General Options panel of the Project Settings.

 � Start TC: The first timecode value in the source media.

 � Start: The first frame number in the source media.

 � End: The last frame number in the source media.

 � Frames: The duration of each clip in frames.

 � Resolution: The frame size of the source media.

 � Bit Depth: The bit depth of the source media.

 � Video Codec: The codec used for the video track of supported media.

 � Audio Codec: The codec used for the audio tracks of supported media.

 � FPS: The frame rate of the source media.

 � Audio Ch: The number of audio channels within the source media.

 � Date Created: The date a media file has been created.

 � Date Modified: The date a media file has been changed in some way and saved.

 � Shot: Additional metadata from media formats that support it.

 � Scene: Additional metadata from media formats that support it.

 � Take: Additional metadata from media formats that support it.

 � Angle: Additional metadata from media formats that support it.

 � Good Take: Additional metadata from media formats that support it.
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If you work in List view, you gain additional organizational control by exposing columns that 
show the metadata that each clip contains, prior to media being added to your timeline. You can 
use these columns to help organize your media.

Methods of customizing metadata columns in List view:
 � To show or hide columns: Right-click at the top of any column in the Media Storage 

browser and select an item in the contextual menu list to check or uncheck a particular 
column. Unchecked columns cannot be seen.

 � To rearrange column order: Drag any column header to the left or right to rearrange 
the column order.

 � To resize any column: Drag the border between any two columns to the right or left to 
narrow or widen that column.

 � To sort by any column: Click the column header you want to sort with. Each additional 
time you click, the same header toggles that column between ascending and 
descending sort order.

You can also customize column layouts in the Media Storage area. Once you’ve customized a 
column layout that works for your particular purpose, you can save it for future recall. 

Methods of saving and using custom column layout:
 � To create a column layout: Show, hide, resize, and rearrange the columns you need 

for a particular task, then right-click any column header in the Media Pool and choose 
Create Column Layout. Enter a name in the Create Column Layout dialog, and click OK.

 � To recall a column layout: Right-click any column header in the Media Pool and choose 
the name of the column layout you want to use. All custom column layouts are at the 
top of the list.

 � To delete a column layout: Right-click any column header in the Media Pool and 
choose the name of the column layout you want to delete from the Delete Column 
Layout submenu.

Thumbnail View
While in Thumbnail view, you can scrub through a clip’s icon to see its contents, and you can 
also click the Clip Info pop-up menu at the bottom right corner of any clip’s thumbnail to see an 
instant summary of that clip’s vital information, including:

 � File name: The name of that file.

 � In timecode: The first frame in the source media.

 � Out timecode: The last frame in the source media.

 � Duration: The total duration of the source media.

 � Resolution: The frame size of the source media.

 � Frame Rate: The frame rate, in fps, of the source media.

 � Pixel Aspect Ratio: The aspect ratio of the source media.

 � Codec: Which codec is used by the source media.

 � Date Created: The date created metadata from the source media file.

 � Flags: Flag metadata applied either by the camera that shot the media, in the Metadata 
Editor, or in the Color page Timeline.
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Also while in Thumbnail view, you can use the Thumbnail Sort pop-up menu (between the zoom 
slider and the Thumbnail view button) to choose a criteria by which to organize the thumbnails. 
Options include File Name, Reel Name, Start TC, FPS, Audio Ch, and Date Modified.

The Thumbnail Sort pop-up in the 
Media Storage browser

Revealing a Finder Location in the Media Browser
If you drag a folder from the macOS Finder into the Media Storage browser, the Media Storage 
browser will immediately update to show the location of that folder.

Viewer
Clips that you select in any area of the Media page show their contents in the Viewer. The 
current position of the playhead is shown in the timecode field at the upper right-hand corner of 
the Viewer.

Viewer
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Simple transport controls appear underneath the jog bar, letting you Jump to First Frame, Play 
Backward, Stop, Play Forward, and Jump to Last Frame. A jog control to the left of these 
buttons lets you move through a long clip more slowly; click it and drag to the left or right to 
move through a clip a frame at a time.

To the right of the transport controls, In and Out buttons let you set In and Out points for the 
current clip. The current In and Out points are indicated in the jog bar, and their timecode 
values, along with the resulting clip duration, are shown in the In, Out, and Duration timecode 
fields below. The Cue buttons move the playhead to these In and Out cue points. The clip’s 
timecode is also displayed at the top right.

A jog or scrubber bar appears directly underneath the image, letting you drag the playhead 
directly with the pointer. The full width of the jog bar represents the full duration of the clip in 
the Viewer.

There’s an additional option for the Media Page Viewer that you can expose by choosing Mark 
In/Mark Out Timecode from the Viewer option menu. This reveals an info bar at the top of the 
Viewer that displays the In and Out timecode, as well as the duration of the currently marked 
section of media.

An optional info bar for showing the timecode and duration of a marked section of media

You can also put the Viewer into Cinema Viewer mode by choosing Workspace > Viewer Mode 
> Cinema Viewer (Command-F), so that it fills the entire screen. This command toggles Cinema 
Viewer mode on and off.

Live Media Preview
Enabled by default, the Live Media Preview setting found in the Viewer options menu (the 
three-dots menu found at the upper right-hand corner of the Viewer) makes it possible for 
thumbnails that you’re skimming in either the Media Storage browser or Media Pool to show the 
skimmed frame in the Viewer. When skimming with Live Media Preview enabled, the playhead 
that appears in the thumbnail is locked to the playhead displayed in the Viewer’s jog bar. You 
can turn Live Media Preview on or off.

When Live Media Preview is on in the Viewer options menu, 
skimming thumbnails mirrors to the Viewer
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Media Pool
The Media Pool is central to the DaVinci Resolve experience. It contains all of the media that 
you import into the current project, as well as all of the timelines you create. It also contains all 
media that’s automatically imported along with Projects, Timelines, or Compositions that have 
themselves been imported into DaVinci Resolve. In the Media page, enough room is given to 
the Media Pool to make it an ideal place to sort, sift through, and organize the clips in your 
project. However, the Media Pool is also mirrored in the Edit, Fusion, Color, and Fairlight pages, 
so you can access clips as you build timelines, composites, grades, and sound design.

Media Pool with the Bin list open

The Bin List
Ordinarily, all media imported into a project goes into the Master bin, which is always at the top 
of the Bin list and encompasses everything in a given project. However, you can add bins of 
your own, and the Media Pool can be organized into as many user-definable bins as you like, 
depending on your needs. Media can be freely moved from one bin to another from within the 
Media Pool. When working in projects with multiple bins, you can choose to expose the bin 
structure in one of two ways:

 � Bin list open: The Bin List button at the upper left-hand corner of the Media Pool lets 
you open a separate List view showing all bins in your project, hierarchically. Bins that 
contain other bins appear with a disclosure button to their left, that you can use to show 
or hide the contents. With the Bin list exposed, it’s easy to organize clips among a large 
collection of bins.

 � Bin list closed: When the Bin list is closed, all bins are hidden, and contents of 
whichever bin is currently selected populate the Media Pool browser.

Showing Bins in Separate Windows
If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin 
into its own window. Each window is its own Media Pool, complete with its own Bin, Power Bins 
and Smart Bins lists, and display controls. 

This is most useful when you have two displays connected to your workstation, as you can drag 
these separate bins to the second display while DaVinci Resolve is in single screen mode. If you 
hide the Bin list, not only do you get more room for clips, but you also prevent accidentally 
switching bins if you really want to only view a particular bin’s contents in that window. You can 
have as many additional Bin windows open as you care to, in addition to the main Media Pool 
that’s docked in the primary window interface.
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Media Pool bins opened as new windows

Bins, Power Bins, and Smart Bins
There are actually three kinds of bins in the Media Pool, and each appears in its own section of 
the Bin list. The Power Bin and Smart Bin areas of the Bin list can be shown or hidden using 
commands in the View menu (View > Show Smart Bins, View > Show Power Bins). Here are the 
differences between the different kinds of bins:

 � Bins: Simple, manually populated bins. Drag and drop anything you like into a bin, 
and that’s where it lives, until you decide to move it to another bin. Bins may be 
hierarchically organized, so you can create a Russian dolls nest of bins if you like. 
Creating new bins is as easy as right-clicking within the Bin list and choosing Add Bin 
from the contextual menu.

 � Power Bins: Hidden by default. These are also manually populated bins, but these 
bins are shared among all of the projects in your current database, making them ideal 
for shared title generators, graphics movies and stills, sound effects library files, music 
files, and other media that you want to be able to quickly and easily access from any 
project. To create a new Power Bin, show the Power Bins area of the Bin list, then right-
click within it and choose Add Bin.

 � Smart Bins: These are procedurally populated bins, meaning that custom rules 
employing metadata are used to dynamically filter the contents of the Media Pool 
whenever you select a Smart Bin. This makes Smart Bins fast ways of organizing the 
contents of projects for which you (or an assistant) has taken the time to add metadata 
to your clips using the Metadata Editor, adding Scene, Shot, and Take information, 
keywords, comments and description text, and myriad other pieces of information to 
make it faster to find what you’re looking for when you need it. To create a new Smart 
Bin, show the Smart Bin area of the Bin list (if necessary), then right-click within it and 
choose Add Smart Bin. A dialog appears in which you can edit the name of that bin and 
the rules it uses to filter clips, and click Create Smart Bin.
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Filtering Bins Using Color Tags
If you’re working on a project that has a lot of bins, you can apply color tags to identify particular 
bins with one of eight colors. Tagging bins is as easy as right-clicking any bin and choosing the 
color you want from the Color Tag submenu.

For example, you can identify the bins that have clips you’re using most frequently with a red 
tag. A bin’s color tag then appears as a colored background behind that bin’s name.

Using Color Tags to identify bins

Once you’ve tagged one or more Media Pool bins, you can use the Color Tag Filter pop-up 
menu (the pop-up control to the right of the Bin List button) to filter out all but a single 
color of bin.

Using Color Tag filtering to 
isolate the blue bins

To go back to seeing all available bins, choose Show All from the Color Tag Filter pop-up.
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Sorting the Bin List
The Bin list (and Smart Bin list) of the Media Pool can be sorted by bin Name, Date Created, or 
Date Modified, in either ascending or descending order. Simply right-click anywhere within the 
Bin list and choose the options you want from the Sort by submenu of the contextual menu.

You can also choose User Sort from the same contextual menu, which lets you manually drag all 
bins in the Bin list to be in whatever order you like. As you drag bins in this mode, an orange line 
indicates the new position that bin will occupy when dropped.

Dragging a bin to a new position 
in the Bin list in User Sort mode

If you use User Sort in the Bin list to rearrange your bins manually, you can switch back and forth 
between any of the other sorting methods (Name, Date Created, Date Modified) and User Sort 
and your manual User Sort order will be remembered, making it easy to use whatever method of 
bin sorting is most useful at the time, without losing your customized bin organization.

Thumbnail View and List View in the Media Pool
The contents of the Media Pool can be browsed one of two ways:

 � Thumbnail view: Each clip is represented by an icon, with its file name appearing 
underneath. When you move the pointer over a clip’s icon, DaVinci Resolve 
automatically scrubs through that clip, showing you its contents. Also, a Clip Info pop-
up menu appears in the lower right-hand corner. Click the Clip Info pop-up to see an 
overlay appear showing essential information about that clip. In Thumbnail view, you 
can use the Sort Order pop-up to choose how clips are sorted.

 � List view: Each clip is represented by an item on a text list. Additionally, multiple 
columns of information appear, organized by headers. Clicking any header lets you sort 
the list by that column, in either ascending or descending order.

For more information about browsing the contents of the Media Pool, see Chapter 11, “Adding 
and Organizing Media with the Media Pool.”

Display Audio Clip Waveforms in 
Media Pool and Media Storage
The Media Pool option-menu presents an option to Show Audio Waveforms. When you do so, 
every audio clip in the Media Pool appears with an audio waveform within its thumbnail area. If 
Live Media Preview is on in the Source Viewer, you can then scrub through each clip and hear 
its contents. If you don’t want to see audio waveforms, you can turn this option off.
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You can now enable waveform thumbnails in the 
Media Pool that you can scrub with Live Media 
Preview

Searching for Content in the Media Pool
An optional Search field can be opened at the top of the Media Pool that lets you quickly find 
clips by name, partial name, or any of a wide variety of Media Pool metadata. 

To search for a clip by name:
1 Select which bin or bins you want to search.

2 Click the magnifying glass button at the upper right-hand corner of the Media Pool.

3 Choose the particular column of information you want to search (or All Fields to search 
all columns) using the Filter by pop-up menu. Only selected bins will be searched.

4 Type your search string into the Search field that appears. A few letters should be 
enough to isolate only those clips that have that character string within their name. To 
show all clips again, click the cancel button at the right of the search field.

TIP: Smart Bins are essentially multi-criteria search operations that scope the entire 
project at once and are saved for future use.

If you’ve synced dual-system audio and video clips together in DaVinci Resolve, you can find 
the audio clip that a video clip has been synced to using the following procedure.

To find the audio clip that a video clip has been synced to:
Right-click a video clip that’s been synced to audio, and choose “Reveal synced audio in Media 
Pool” from the contextual menu. The bin holding the synced audio clip is opened and that clip 
is selected.
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Taking Advantage of the Media Pool’s Usage Column
In List view, the Usage column does not automatically update to show how many times a 
particular clip has been used. However, you can manually update this metadata by right-clicking 
within the Media Pool and choosing Update Usage Data from the contextual menu that 
appears. Afterwards, each clip will display how many times it’s been used in this column. Clips 
that have not been used yet display an x.

Metadata Editor
Both the Media and Edit pages have a Metadata Editor. When you select a clip in any area of 
the Media page, its metadata is displayed within the Metadata Editor. If you select multiple clips, 
only the last clip’s information appears. The Metadata Editor’s header contains uneditable 
information about the selected clip, including the file name, directory, duration, video codec, 
frame rate, resolution, audio codec, sample rate, and number of channels.

Because there are so very many metadata fields available, two pop-up menus at the top let you 
change which set of metadata is displayed in the Metadata Editor.

 � Metadata Presets (to the left): If you’ve used the Metadata panel of the User 
Preferences to create your own custom sets of metadata, you can use this pop-up to 
choose which one to expose. Surprisingly enough, this is set to “Default” by default.

 � Metadata Groups (to the right): This pop-up menu lets you switch among the various 
groups of metadata that are available, grouped for specific tasks or workflows.

The heart of the Metadata Editor is a series of editable fields underneath the header that let you 
review and edit the different metadata criteria that are available. For more information on 
editing clip metadata and creating custom metadata presets, see Chapter 12, “Using 
Clip Metadata.”

Clip Metadata Editor showing the Clip Details panel
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Audio Panel
The Audio Panel can be put into one of two modes via an option menu. In the default Meters 
mode, audio meters are displayed that show the levels of audio in clips you’re playing. In 
Waveform mode, you can open audio clips side by side with video clips in the Viewer in order 
to sync them together manually.

When set to Levels mode, you can check audio embedded within clips you’ve imported into the 
Media Pool. As you play a clip, each audio meter shows the levels for whichever of these tracks 
contain audio. You can toggle individual tracks on and off by clicking the track number 
underneath. A Mute button, at the bottom-left of the meters, lets you disable and enable 
audio playback.

Audio Meters Exposed
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Dual Monitor Layout
The Media page has a dual monitor layout that provides maximum space for the Media Storage 
browser and Media Pool on the primary monitor, and an enlarged Viewer, Audio Panel, and 
Metadata Editor on the secondary monitor, along with a complete set of video scopes for 
helping you to evaluate media as you organize it.

To enter dual screen mode:
Choose Workspace > Dual Screen > On.

The Media page in dual screen mode

To switch which UI elements appear on which monitors:
Choose Workspace > Primary Display > Display 1 or Display 2, which reverses the 
contents of both monitors in dual screen mode.
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Customizing the Media Page
The Media Page can be customized to create more room in different areas to accommodate 
specific tasks.

To resize any area of the Media page:
Drag the vertical or horizontal border between any two panels to enlarge one and 
shrink the other.

Methods of hiding different parts of the Media page:
 � To toggle the Clone Tool on and off: Click the Clone Tool button in the UI toolbar at 

the top.

 � To toggle the Audio Panel on and off: Click the Audio button in the UI toolbar at 
the top.

 � To toggle the Metadata Editor on and off: Click the Metadata button in the UI toolbar 
at the top.

 � To toggle the Media Storage browser folder list on and off: Click the button at the 
top-left corner of the Media Browser.

 � To toggle the Media Pool Bin list on and off: Click the button at the top-left corner of 
the Media Pool.

Methods of organizing favorite file system locations in the Media Storage browser:
 � To add a favorite: Right-click any folder in the Media Storage browser folder list, and 

choose “Add folder to favorites” from the contextual menu.

 � To remove a favorite: Right-click the favorite you want to remove, and choose “Remove 
folder from favorites” from the contextual menu.

To return all pages to their default layout:
Choose Workspace > Reset UI Layout.

Undo and Redo in DaVinci Resolve
No matter where you are in DaVinci Resolve, Undo and Redo commands let you back out of 
steps you’ve taken or commands you’ve executed and reapply them if you change your mind. 
DaVinci Resolve is capable of undoing the entire history of things you’ve done since creating or 
opening a particular project. When you close a project, its entire undo history is purged. The 
next time you begin work on a project, its undo history starts anew.

Because DaVinci Resolve integrates so much functionality in one application, there are three 
separate sets of undo “stacks” to help you manage your work.

 � The Media, Edit and Fairlight pages share the same multiple-undo stack, which lets you 
backtrack out of changes made in the Media Pool, the Timeline, the Metadata Editor, 
and the Viewers.

 � Each clip in the Fusion page has its own undo stack so that you can undo changes you 
make to the composition of each clip, independently.

 � Each clip in the Color page has its own undo stack so that you can undo changes you 
make to grades in each clip, independently.
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In all cases, there is no practical limit to the number of steps that are undoable (although there 
may be a limit to what you can remember). To take advantage of this, there are three ways you 
can undo work to go to a previous state of your project, no matter what page you’re in.

To simply undo or redo changes you’ve made one at a time:

 � Choose Edit > Undo (Command-Z) to undo the previous change.

 � Choose Edit > Redo (Shift-Command-Z) to redo to the next change.

 � On the DaVinci control panel, press the UNDO and REDO buttons on the T-bar panel.

TIP: If you have the DaVinci control panel, there is one other control that lets you 
control the undo stack more directly when using the trackballs, rings, and pots. 
Pressing RESTORE POINT manually adds a memory of the current state of the grade to 
the undo stack. Since discrete undo states are difficult to predict when you’re making 
ongoing adjustments with the trackball and ring controls, pressing RESTORE POINT 
lets you set predictable states of the grade that you can fall back on.

You can also undo several steps at a time using the History submenu and window. At the time 
of this writing, this only works for multiple undo steps in the Media, Edit, and Fairlight pages.

To undo and redo using the History submenu:

1 Open the Edit > History submenu, which shows (up to) the last twenty things you’ve 
done.

2 Choose an item on the list to undo back to that point. The most recent thing you’ve 
done appears at the top of this list, and the change you’ve just made appears with a 
check next to it. Steps that have been undone but that can still be redone remain in this 
menu, so you can see what’s possible. However, if you’ve undone several changes at 
once and then you make a new change, you cannot undo any more and those steps 
disappear from the menu.

The History submenu, which lets you undo several steps at once

Once you’ve selected a step to undo to, the menu closes and the project updates to show you 
its current state.
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To undo and redo using the Undo window:
1 Choose Edit > History > Open History Window.

2 When the History dialog appears, click an item on the list to undo back to that point. 
Unlike the menu, in this window the most recent thing you’ve done appears at the 
bottom of this list. Selecting a change here grays out changes that can still be redone, 
as the project updates to show you its current state.

The Undo history window that lets you browse the 
entire available undo stack of the current page

3 When you’re done, close the History window.
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Chapter 11

Adding and 
Organizing 
Media with the 
Media Pool

Before you can edit or grade media, you need to add it to the Media Pool, 
which is the central repository of clips in DaVinci Resolve. The Media Pool 
is a feature-rich environment, giving you many different methods of 
importing clips into your project and organizing them.
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Copying Media Using the Clone Tool
One of the few things you may want to do before you add media to your project is to clone all 
camera original media onto a safe set of backup volumes, for redundancy in case any one 
volume fails. Additionally, you should consider cloning all media to an off-site backup as well.

Whether you’re on-set working as a DIT, or doing data ingest at a post facility, the Clone Tool in 
the Media page lets you safely and accurately copy media from SD cards, SSDs, or disk drives, 
to multiple destinations, with a checksum report (based on a choice of six checksum options) 
written to the root of each destination volume that verifies the absolute accuracy of the 
duplicate media saved to each destination.

To duplicate media using the Clone Tool:
1 Open the Clone Tool by clicking the Clone button at the far left of the Media Pool 

toolbar, which reveals the Clone Tool palette. 

2 Click the Add Job button at the bottom left to create a new job. A job item appears 
within the Clone Tool palette, with overlays to guide you through its use.

3 Drag a volume or folder from the Media Storage panel to the “Drop source here” drop 
zone. Alternately, you can right-click any volume or folder in the Media Storage panel 
and choose Set As Clone Source.

4 Next, drag one or more volumes or folders from the Media Storage panel to the “Drop 
destination here” drop zone. Alternately, you can right-click any volume or folder in the 
Media Storage panel and choose Set As Clone Destination. You can have more then 
one destination. 

5 If you want to preserve the top level folder name from the source volume or folder, click 
the Clone Tool panel’s option menu, and choose “Preserve Folder Name.” The overall 
folder structure of the cloned media is always preserved.

6 If you want to change the checksum method used by DaVinci Resolve to verify that 
each clip has copied properly, you can choose an option from the Checksum submenu 
of the Clone Tool’s option menu. Each option is a tradeoff between the speed of 
your file copy operation and the security of the verification process. Greater security 
generally means a slower copy operation. The options are:

 � None: Disables data verification, sacrificing safety for speed.

 � File Size: Fast, but minimal data verification. Data verification is done simply 
by comparing the file size of a duplicate file with that of the original. “Collision 
resistance” refers to whether two files (or a file and an incorrectly duplicated file) may 
coincidentally have the same comparison value (be it file size, an error-detecting 
code, or a hash). File Size is very fast, but it’s minimally collision resistant.

 � CRC 32: Faster than MD5, but less secure. An error-detecting code rather than the 
hash used by the next three options. A “check value” is generated based on the 
remainder of a polynomial division of the file’s contents. By comparing the check 
value derived from an original file with that derived from a copy, data integrity can be 
verified. This is a much faster data verification scheme than MD5 (the default), but it is 
significantly less collision resistant.

 � MD5: This is the default setting. A reasonable tradeoff between speed and security. 
A hash function generates a 128-bit value that’s unique to a particular file; Data 
integrity is checked by comparing the hash value generated by the original file to that 
generated by the copied file. MD5 is not as collision resistant as the SHA options, but 
it’s a faster operation, and the probability of such collisions in conventional film and 
video workflows is probably small.
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 � SHA 256, SHA 512: Slower, but more secure. SHA is a more collision resistant hash 
function than MD5; options are provided for 256- and 512-bit value generation, 
with 512 being even more collision resistant than 256. However, these options are 
progressively slower than MD5, and will result in significantly slower copy times. 
Similarly to MD5, data integrity is checked by comparing the hash value generated by 
the original file to that generated by the copied file.

7 When you’re ready, click the Clone button to initiate the cloning process.

To duplicate media quickly using the Clone Tool:
1 Right-click any volume or folder in the Media Storage panel, and choose Set as Clone 

Source. A job item appears within the Clone Tool palette, populated by the volume or 
folder you selected.

2 Next, right-click any volume or folder in the Media Storage panel, and choose Set As 
Clone Destination. You can do this more than once because you can have more than 
one destination. 

3 If you want to preserve the top level folder name from the source volume or folder, click 
the Clone Tool panel’s option menu, and choose “Preserve Folder Name.” The overall 
folder structure of the cloned media is always preserved.

4 When you’re ready, click the Clone button to initiate the cloning process.

The Clone tool with a job set up
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Adding Media to the Media Pool
At minimum, you’ll be using the Media page to add clips to a project to begin editing, in 
preparation to create dailies, or as a prelude to conforming a project using an EDL. All clips you 
want to work with must first be added to the Media Pool to be available for grading and 
processing in DaVinci Resolve, regardless of whether or not there’s edited project data to go 
along with it.

If you import XML or AAF projects, you can choose to automatically import all accompanying 
media as part of the import process you initiate in the Edit page. However, if you find yourself 
needing to replace updated effects or stock footage in the Timeline, or you’re called upon to 
add additional media such as animated titles or superimposed clips for compositing, then you’ll 
still need to use the Media page to do so. 

Whatever kind of project you’re working on, you can add clips to the Media Pool from as many 
different volumes as you need. All imported clips are linked to the original media on whichever 
disks you found them; files are not moved, copied, or otherwise transcoded when you add 
them to the Media Pool. Consequently, it’s a good idea to make sure that all media you want to 
import into your project has already been copied to a suitably fast volume before importing it.

Basic Methods for Adding Media in the Media Page
There are several ways of adding clips to the Media Pool.

To add individual clips from the Media Storage panel to the Media Pool:

1 Use the Media Storage panel to find a media file to import. 

2 If you have multiple bins available in the Bin list, choose the bin you want to add the 
incoming media to.

3 Do one of the following:

 – Shift-click or Command-click multiple files, then right-click one of the selected files 
and choose “Add into Media Pool.”

 – Drag a clip from the Media Storage panel browser to the Media Pool or to a specific 
bin in the Bin list.

4 If a dialog appears asking if you want to change your project to match the criteria, click 
“Change” to alter the project’s settings, or click “Don’t Change” to continue importing 
the media while leaving the project at its previous frame rate. Once clips have been 
imported into the Media Pool, the frame rate cannot be changed again, so choose 
carefully.

You also have the option of dragging media directly from the file system of supported platforms 
into the Media Pool.

To drag one or more clips from the File System to the Media Pool (supported platforms only):
1 Select one or more clips in your File System.

2 Drag those clips into the Media Pool of DaVinci Resolve or to a specific bin in the Bin list.

Those clips are added to the Media Pool of your project.

If you need to add the contents of all directories and subdirectories to the Media Pool as a flat 
group of media, that’s easily accomplished. A good example of this is when you’re importing 
camera original media from a cloned file structure, in which clips are organized into 
subdirectories that are many levels deep. DaVinci Resolve can easily import all of these clips 
and put them all into the same bin.
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To add the entire contents of one or more directories of clips to the Media Pool:
1 Use the Media Storage panel to find and select one or more directories containing 

media files you need to import.

2 If you have multiple bins available in the Bin list, select the specific bin you want to add 
the incoming media to.

3 Do one of the following:

 – Right-click the selected directory or directories in the Media Storage panel, and 
choose “Add Folder into Media Pool” to add only clips from the selected directory. 
Subdirectories are ignored.

 – Right-click the directory in the Media Storage panel, and choose “Add Folder and 
SubFolders into Media Pool” to add clips from the selected directory and those from 
all subdirectories within.

 – Drag one or more selected directories you want from the Media Storage panel’s 
browser area to the browser area of the Media Pool to add its contents, and the 
contents of all subdirectories within, to the currently selected bin in the Bin list.

You also have the option of using the directories and subdirectories that organize media in your 
file system as bins in the Media Pool, so that you can preserve the original organization of 
your media.

To add all clips and folders in a directory organized into matching folders in the Media Pool:
1 Use the Media Storage panel to find the directory containing the files you need 

to import.

2 Do one of the following:

 – Right-click the directory and choose “Add Folder and SubFolders into Media Pool 
(Create Bins)”

 – Drag the folder you want to import from the Media Storage panel to the Bin list of the 
Media Pool to add that folder, and all subfolders within, as a new bin in the Bin list.

A folder appears in the Media Pool with the same name as the folder you dragged in. All clips 
and all subdirectories appear within, nested hierarchically in the Media Pool as they were in the 
file system.

Import Hierarchically Organized Nests of Empty Directories

You can also import a nested series of directories and subdirectories that constitutes a 
default bin structure you’d like to bring into projects, even if those directories are 
empty, by dragging them from your file system into the Media Pool Bin list of a project. 
The result is a hierarchically nested series of bins that mimics the structure of the 
directories you imported. This is useful if you want to use such a series of directories 
as a preset bin structure for new projects.

Adding Subclips From the Media Storage Panel
If you’re browsing long source clips in the Media Storage panel, but you only want to import a 
small segment of a much longer clip into the Media Pool, you can create subclips directly from 
the Media Storage panel.
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To add a subclip from a clip in the Media Storage panel to the Media Pool:
1 Single-click any clip in the Media Storage panel to open it into the Viewer in order to 

create a subclip without needing to first import that clip into the Media Pool.

2 Set In and Out points in the Source Viewer to define the section you want to turn into a 
subclip.

3 Do one of the following:

 – Right-click the jog bar and choose Make Subclip from the contextual menu

 – Drag the clip from the Viewer to the Media Pool to add it as a subclip

Adding Individual Frames From Image Sequences
If you’re working with image sequences, or with sequentially numbered image files from any 
source, DaVinci Resolve automatically presents them as clips in the Media Storage panel. This 
is good if that’s what they are, but there are instances where sets of photos, of which each 
frame is in actuality a separate media file, are also sequentially numbered. For this reason, you 
can import individual frames, rather than entire image sequences.

To add an individual frame from a number sequence of images in the Media Storage panel:
1 Click the Media Storage panel option menu, and choose Show Individual Frames. Each 

image sequence is now separated into its individual frames, allowing you to select only 
the frames you need.

2 Use any of the previous described methods to add the frames you want to the Media 
Pool as individual clips.

Adding Media Based on EDLs
Another strategy for adding media to the Media Pool is to use an EDL to add only the clips it 
refers to from a directory. This lets you add only the clips that are necessary for conforming a 
particular imported project before conforming an EDL, and eliminates the need to add too much 
media to the Media Pool, which might slow you down in the case of projects referencing 
terabytes of media. Furthermore, you can choose multiple EDLs to base the import on, and 
many directories to examine.

The EDLs will reference clips via their timecode and sometimes reel name and path. It is these 
settings and the conform frame rate that you made previously in the Configuration screen that 
are now used to place images correctly into the Media Pool.

To add only media used in an EDL to the Media Pool:
1 If necessary, open the General Options panel of the Project Settings, turn on the 

“Assist using reel names from the” checkbox, and choose a method with which to 
extract reel name information from the media files you’re about to import. For more 
information, see Chapter 12, “Using Clip Metadata.”

2 Right-click a directory in the Media Storage panel, and choose one of the 
following commands:

 � Add Folder Based on EDLs into Media Pool

 � Add Folder and SubFolders Based on EDLs into Media Pool

3 Using the file dialog that appears, select one or more EDLs to use.

DaVinci Resolve searches the directory hierarchy, either one level deep or all levels deep, 
for every media file matching the source timecode and the reel ID of an event in one of the 
selected EDLs.
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Splitting Clips Based on EDLs
You can also use EDLs to split a media file into multiple clips in the Media Pool, either as an 
alternate means of “preconforming” a flattened master media file, or to import multiple sections 
of a longer media file that happen to be referenced by an EDL.

To split and add clips based on an EDL:
1 Right-click a directory in the Media Storage panel, and choose “Split and add into 

Media Pool.”

2 Using the file dialog that appears, select an EDL to use, and click Open.

3 Choose a frame rate to use to conform the clips to in the “File Conform Frame Rate” 
dialog, and click OK.

4 Choose a handle size, in frames, and whether or not you want to split unreferred clips 
from the “Enter handle size for splitting” dialog, and click Split & Add. The media file is 
split into the component clips specified in the EDL, and added to the Media Pool.

TIP: Turning on the Split Unreferred Clips checkbox automatically splits out sections of 
the file that were not referred to by the EDL you selected, and adds them to the Media 
Pool separately, giving you access to every piece of media that’s available.

Import Clips With Metadata Via Final Cut Pro 7 XML
In order to support workflows with media asset management (MAM) systems, DaVinci Resolve 
supports two additional Media Pool import workflows that use Final Cut Pro 7 XML to import 
clips with metadata.

To import clips with metadata using Final Cut Pro 7 XML files, do one of the following:
 � Right-click anywhere in the background of the Media Pool, choose Import Media 

from XML, and then choose the XML file you want to use to guide import from the 
import dialog.

 � Drag and drop any Final Cut Pro 7 XML file into the Media Pool from the macOS Finder.

Every single clip referenced by that XML file that can be found via its file path will be imported 
into the Media Pool, along with any metadata entered for those clips. If the file path is invalid, 
you’ll be asked to navigate to the directory with the corresponding media. Additionally, the 
following metadata is imported:

 � Clips

 � Browser metadata

 � Subclips

 � Clip Markers, with colors and duration

 � Bin Hierarchy

Adding Media With Offset Timecode
Sometimes source media was created with incorrectly offset timecode, due to mistakes made 
earlier in the postproduction process. If this offset is consistent, you can use the “Add Folder 
with Source Offset” command to add media to the Media Pool as clips with a timecode offset.
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To add a folder of clips to the Media Pool with offset timecode:
1 Right-click a directory in the Media Storage panel, and choose one of the 

following commands:

 � Add Folder with Source Offset

 � Add Folder and SubFolders with Source Offset

2 Choose a number of frames with which to offset the timecode from the “Change Frame 
Offset” dialog, and click Apply.

The media is imported as clips with offset timecode in the Media Pool. However, the original 
source timecode of the clips on disk has not been altered. All media rendered out of the Deliver 
page will reflect the offset timecode.

Adding Media to the Edit 
and Fairlight Pages
While adding clips to the Media Pool in the Media page provides the most organizational 
flexibility and features, if you find yourself in the Edit or Fairlight page and you need to quickly 
import a few clips for immediate use, you can do so in a couple of different ways.

To add media by dragging one or more clips from the Finder to the Edit page Media Pool 
(macOS only):

1 Select one or more clips in the Finder.

2 Drag those clips into the Media Pool of DaVinci Resolve, or to a bin in the Bin list.

Those clips are added to the Media Pool of your project.

To use the Import Media command in the Edit page Media Pool:
1 With the Edit page open, right-click anywhere in the Media Pool, 

and choose Import Media.

2 Use the Import dialog to select one or more clips to import, and click Open.

Those clips are added to the Media Pool of your project.

Removing Media From the Media Pool
If you’ve added clips to the Media Pool that you need to eliminate, this is easy to do, either 
singly, or in the aggregate.

To remove clips from the Media Pool, do one of the following:
 � Select one or more clips in the Media Pool, then press the Delete or Backspace key.

 � Select one or more clips in the Media Pool, right-click one of the selected clips, and 
then choose Remove Selected Clips.

 � Right-click anywhere in the Media Pool, and choose Remove All Clips in Bin.

NOTE: If you’ve turned on “Automatically match master timeline with media pool” in the 
General Options panel of the Project Settings, you cannot remove all clips from the 
Media Pool if there are other timelines using that media.
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To remove clips from the Master Timeline (if it’s exposed):
Open the Edit page, then select one or more clips in the Media Pool, right-click one of 
the selected clips, and choose “Remove Selected Clips from Master Timeline.”

For more information about using the Master Timeline, see Chapter 18, “Using the Edit Page.”

Adding and Removing External Mattes
If you’ve been provided with matte files to accompany one or more media files used by a 
program you’re grading, you can attach them directly to specific clips in the Media Pool, in order 
to use them as key sources for a Clip Grade in the Node Editor of the Color page. You can even 
use matte files that pack multiple mattes within a single piece of media. This can be done by 
either writing different mattes to each of the red, green, and blue channels of a clip, or by 
embedding multiple matte passes within a single OpenEXR file.

Matching RGB and Matte images

When the Media Pool is in Icon view, clips with clip mattes appear with a badge.

A clip matte, seen in Icon view

Clip mattes appear listed underneath a clip in the Media Pool when it’s in List view.

Chapter – 11 Adding and Organizing Media with the Media Pool 261



A clip matte, seen in List view

Alternately, you can add a timeline matte to the Media Pool, which isn’t attached to any 
clip, that can be used as a key source in the Color page within any clip’s Clip grade, or 
within a Timeline Grade. Timeline mattes appear as stand-alone clips in the Media Pool.

A timeline matte, seen in Thumbnail view

What Are Mattes For?
Matte files are useful for two things. Traditionally, mattes are grayscale media files that identify 
regions of varying opacity, with white representing solid areas, and black representing 
transparency. For example, exported clips from a compositing application sometimes are 
accompanied by one or more matte files that correspond to keys or rotoscoped mattes from the 
composite. By importing these matte files using the “Add as Matte” command, you can attach 
them to the clips they belong to in the Media Pool, so that they’re only available to the clips 
they’re synced to.

However, mattes can also be used as creative tools to apply grain and texture for effect. What a 
matte does depends on how you connect it in the Node Editor of the Color page. These are 
media files that you may want to use as mattes for potentially any clip, so they can also be 
added to the Media Pool as a so-called timeline matte, that can be applied to any clip you want.

TIP: If necessary, you can also apply LUTs to both clip mattes and timeline mattes in 
the Media Pool, simply by right-clicking a matte, and choosing a LUT from the 1D LUT 
or 3D LUT submenus. This can be helpful for adjusting incorrectly formatted mattes.

Adding Mattes
To use mattes, you need to add them in very specific ways.

To assign a matte to a clip in the Media Pool:
1 Select a clip in the Media Pool to which you want to attach an external matte.

2 Select the matching external matte file in the Media Storage panel, right-click it, and 
choose Add to Media Pool as a Matte.

The matte is attached to the clip as a clip matte. A badge indicates that clip has a 
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matte when the Media Pool is in Icon view, and the matte itself can be seen, if you put 
the Media Pool into List view, appearing as a nested item underneath the clip it’s 
attached to.

Removing mattes from clips in the Media Pool:
1 Put the Media Pool into List view.

2 Right-click the external matte file you need to remove, and choose Remove 
Selected Clips.

Removing an external matte clip also removes that matte’s key from any clip grades 
that use it, such that any clips using it as a key input change from a secondary 
operation to a primary operation, where the color adjustment affects the entire image.

To add a timeline matte to the Media Pool:
1 Make sure no clip is selected in the Media Pool.

2 Select an external matte file in the Media Storage panel, right-click it, and choose Add 
to Media Pool as a Matte

The external matte appears in the Media Pool as a timeline matte.

You can also assign mattes to clips directly in the Color page, which can sometimes be faster.

To assign a matte to a clip in the Color page:
Drag any clip from the Media Pool to the Node Editor. 

That clip appears an an External matte for the current clip’s grade in the Node Editor, 
and it’s also automatically assigned to the current clip in the Media Pool.

For more information on using external matte clips as keys when grading, see Chapter 111, 
“Combining Keys and Using Mattes.”

Using Embedded Mattes in OpenEXR Files
If you’re importing OpenEXR files with embedded matte passes, there’s nothing special you 
need to do, as the mattes are within the clip you’ve just imported into the Media Pool. For more 
information on how to use mattes within OpenEXR files, see Chapter 111, “Combining Keys and 
Using Mattes.”

Adding Offline Reference Movies
When moving a project from another application to DaVinci Resolve, it’s useful to export the 
entire program as a single media file for use as an Offline Reference Movie. Then, you can 
import this file in a special way to use for dual Viewer comparison in the Edit page, or as a 
split-screen comparison for fade wipe in the Color page.

To add a clip as an offline reference clip:
Right-click it in the Media Storage panel, and choose “Add As Offline Clip.”  

That clip appears with a small checkerboard badge in its icon in the Media Pool, or as 
the icon to the left of the Media Pool.

Chapter – 11 Adding and Organizing Media with the Media Pool 263



Checkerboard icon indicating an 
Offline comparison video

For more information on using an offline video to compare with an imported Timeline in the 
Edit page, see Chapter 38, “Preparing Timelines for DaVinci Resolve Import.” For more 
information on split-screen reference of Offline video in the Color page, see Chapter 98, 
“Using the Color Page.”

Extracting Audio in Media Storage
If there’s a video clip in the Media Storage panel that has audio you need, but you don’t want 
the video component, you can use the Extract Audio command to create a self-contained audio 
clip that you can then import into the Media Pool by itself.

To extract the audio from a media file:
1 Right-click a clip in the Media Storage panel, and choose Extract Audio.

2 Click the Browse button in the Extract Audio dialog to find another disk location for the 
extracted clip.

3 Click Extract. The audio channels are extracted and written as a .WAV file to the 
selected destination.

4 After you’ve extracted the stand-alone .WAV file, you’ll need to import it into the Media 
Pool if you want to use it in your project.

Organizing the Media Pool
Whether you’re doing onset work, creating digital dailies, organizing media to edit, or ingesting 
media to conform to an imported project, it’s vitally important to stay organized. The Media Pool 
provides many different tools for doing so.

To Select Clips in the Media Pool
There are a variety of ways you can make clip selections in the Media Pool in preparation for 
relinking, unlinking, moving, duplicating, deleting, or doing any other operation to them.

 � Click any clip to select it.

 � Drag a bounding box around several clips to select them all.

 � Hold the Command or Shift keys down and drag a bounding box around another 
discontiguous group of clips to either add them to the current selection or remove them 
from the current selection.
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 � Click one clip, then Shift-click another to select both clips and make a continuous 
selection of all clips in-between. Shift-clicking another clip can expand or contract 
the selection.

 � Command-click individual clips to select a discontiguous number of clips. 
Command-click a clip that’s already selected to individually de-select it, while leaving 
the rest of the selection alone.

 � With one clip selected, hold the Shift or Command keys down and use the Arrow keys 
to expand the selection to other clips.

Organizing Media into Bins
You can easily organize clips into different bins in the Media Pool. For some workflows, this is 
required, while with other workflows it’s purely optional.

Methods of working with bins in the Media Pool:
 � To add a bin to the Media Pool: Right-click in the Bin list and choose Add Bin. To add a 

bin inside another bin, right-click any bin and choose Add Bin.

 � To add a bin and move selected clips into it: Select all the clips you want to put into 
a new bin, then right-click one of the selected clips, and choose Create Bin With 
Selected Clips.

 � To rename a bin: Select the bin you want to rename, and then click its name a second 
time to make it editable. With the bin name highlighted, type a new name and press 
Return. Alternately, you can right-click a bin, choose Rename Bin, and then type a new 
name and press Return.

 � To add incoming clips to a specific bin in the Media Pool: Click a bin to select it, then 
use any of the previously described methods to add media from the Media Storage 
panel directly to that bin.

 � To move media from one bin to another: Drag one or more selected clips from their 
current location in the Media Pool into that bin. Multiple clips in the Media Pool can be 
selected by Shift-clicking or Command-clicking them, or by dragging a bounding box 
over a group of clips. You can also drag one bin into another one.

 � To delete a bin: Select the bin you want to delete, and press the Backspace or Delete 
key. Or, right-click a bin and choose Delete Bin. Deleting a bin with nested bins inside 
of it results in that entire set of bins being deleted.

 � To sort bins: Right-click anywhere within the Bin list, and choose an option from 
the Sort By submenu. You can choose from Name, Date Created, Date Modified, and 
User Sort.

 � To reorganize bins manually: Right-click anywhere within the Bin list, and choose Sort 
By > User Sort. Then, drag bins up or down in the Bin list to put them into the order you 
want. An orange dividing line shows where dragged bins will be placed when you drop 
them and helps you see when a bin you’re dragging will become nested within another 
bin or not. The User Sort order is saved even when you change to another sort order, 
and selecting User Sort again results in your custom sort order being recalled.

Creating and Using Power Bins
Power Bins provide a way of importing and organizing media that you want to be available to all 
projects in DaVinci Resolve. Power Bins reside in a separate area of the Media Pool, with 
resizable dividers separating them from both the ordinary bins and Smart Bins areas. Power 
Bins are hierarchical, just like regular bins, and you can nest as many as you like, one 
inside another.
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The Power Bins area of the Bin list

Like regular bins, Power Bins must be manually created by right-clicking within the Power Bins 
area and choosing Add Bin. The difference is that whatever clips you import into Power Bins are 
shared among all projects in a single-user installation, or all projects belonging to a particular 
user in a multi-user installation. In this way, they’re similar to Power Grades in the gallery of the 
Color page. This makes Power Bins ideal for storing shared media that’s re-used often, such as 
stock video, sound effects, stills, and things like company slates and network graphics and 
animations that go into every show of a series.

Power Bins are created and used like any other bin, using the procedures described previously.

To show or hide the Power Bin area of the Bin list:
Choose View > Show Power Bins to toggle the visibility of all power bins on and off.

Creating and Using Smart Bins
Another completely automated way of organizing media in the Media Pool is to create your own 
custom Smart Bins, in order to sift out clips based on any of the intrinsic or user-entered 
metadata that’s available in the Metadata Editor and Media Pool. Smart Bins work much the 
same way as Smart Filters in the Color page, and they’re created and edited using the same 
procedures. For more information about Smart Filters, see Chapter 98, “Using the Color Page.”

In fact, Smart Bins can be very sophisticated, allowing you to automatically gather clips together 
using multiple criteria, and using multiple groups of multiple criteria for situations where you 
need to gather clips that match all of one set of criteria, but only one of a second set of criteria. 
In this way, you can create Smart Bins to solve a wide variety of organizational needs as you 
edit your program.

It’s important to point out, however, that as much intrinsic metadata is available to every clip in 
DaVinci Resolve automatically (clip properties such as frame rate, frame size, codec, file name, 
and so on), the more time you take entering extra metadata in the Metadata Editor to prepare 
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your project for editing and grading, for example entering scene and take information, and 
keywords for things like character names, day and night, interior and exterior, framing, and so 
on, the more powerful Smart Bins can be in helping you to sift and sort through the contents of 
a program you’re grading.

Imagine being able to gather all the clips in a particular scene, find all the interview clips for a 
particular subject, or find all the establishing shots corresponding to a particular location. If you 
or an assistant can take the time to enter metadata for the source material in a project that 
identifies these characteristics, you’ll be able to work even more quickly to find the clips you 
need for any given situation.

To show or hide the Smart Bin area of the Bin list:
Choose View > Show Smart Bins to toggle the visibility of all Smart Bins on and off.

To create a Smart Bin:
1 If necessary, open the Bin list, choose View > Show Smart Bins, then right-click 

anywhere in the background of the Smart Bin area of the Bin list, and choose Create 
Smart Bin.

2 In the Create Smart Bin dialog, enter a name for the filter, and use the following controls 
to create one or more filter criteria (you can have as many filter criteria as you like):

The Create Smart Bin dialog

 � Match options: For multi-criteria filtering, choosing All ensures that every single criteria 
you specify is met for a clip to be filtered. Choosing Any means that if only one out of 
several criteria is met, that clip will be filtered.

 � Filter criteria enable checkbox: Lets you enable or disable any criteria without having 
to delete it.

 � Metadata category pop-up: Lets you choose which category of metadata you want to 
select a criteria from. Each category of metadata that’s available in the Metadata Editor 
is available from this pop-up menu. Additionally, Color Timeline Properties (containing 
many properties unique to the Color page timeline) and Media Pool Properties 
(containing every column in the Media Pool) provide access to additional metadata you 
can use for filtering.

 � Metadata type pop-up: For choosing which exact type of metadata to use, of the 
options available in the selected metadata category.

 � Metadata criteria pop-up: Lets you choose the criteria by which to filter, depending on 
the metadata you’ve selected. Options include “true/false,” integer ranges, date ranges, 
string searches, flag and marker colors, et cetera.

 � Add filter criteria button: Lets you add additional criteria to create multi-criteria filters. 
You could use multiple criteria to, for example, find all exterior clips, that also contain 
the keyword “Sunset,” that aren’t closeups, in order to find all the exterior long and 
medium shots in sunset lighting. Additionally, if you Option-click this button, you can 
add a nested match option in order to create even more sophisticated filters, such as 
when the filter must match all of one set of criteria, and any of another set of criteria.
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A complicated Smart Bin with multiple criteria and a second match option setting

As you’re editing the filter criteria, the thumbnail timeline automatically updates to show 
you how the Smart Bin you’re creating is working.

3 When you’re done editing the filter criteria, click Create Smart Bin. The resulting Smart 
Bin appears in the Smart Bin area of the Bin list, at the left of the Media Pool’s browser 
area.

Once you’ve created a Smart Bin, it appears in the lower half of the Media Pool’s Bin list, 
alongside every other Smart Bin in that project. This keeps them organized, separate from the 
manually created bin shown above.

All Smart Bins appear together at the 
bottom of the Media Pool’s Bin list

Once you’ve created a Smart Bin, you can re-edit it whenever the situation requires.

Methods of modifying existing Smart Bins:
 � To rename a Smart Bin: Right-click the Smart Bin you want to rename, choose Rename 

from the contextual menu, enter a new name, and press Return.

 � To edit a Smart Bin: Double-click the Smart Bin, then edit the filter criteria, and click 
OK.

 � To delete a Smart Bin: Right-click the Smart Bin you want to delete, choose Delete 
Smart Bin from the contextual menu, and click Delete in the warning dialog. Deleting a 
Smart Bin does not delete any gathered media associated with that bin.
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Smart Bins Work Better With Metadata

Keep in mind that the more metadata you associate with each clip, the more methods 
you have at your disposal for creating custom Smart Bins (for editing) and Smart Filters 
(for grading) with which to zero in on the clips you need for any given situation. This will 
not only make it easier to find what you need, but it’ll help you to work faster. At the 
very least, it would be valuable for you to use the Metadata Editor to add information to 
each clip such as a Description, Shot and Scene designations, take information, and 
possibly some useful keywords such as character names, shot framing, interior or 
exterior keywords, and so on.

For example, if you’ve entered enough metadata, then you can create multi-criteria 
Smart Bins or Smart Filters that let you find the equivalent of “every close-up of Sally 
inside the diner,” or “every long shot of Antonio outside in the parking lot.” In a 
documentary, you could easily isolate “every interview shot of Louis from camera 1,” 
or “every B-roll clip with Robyn.” All of this will help you find media faster for editing, or 
quickly isolate similar clips that you need to match together for grading.

For more information about using the Metadata Editor, see Chapter 12, “Using 
Clip Metadata.”

Duplicating Clips in the Media Pool
You can duplicate clips in order to create an instance of that media that’s treated as a 
completely new source clip, entirely separate from the original instance of that clip that was 
imported into DaVinci Resolve. The duplicate is capable of storing individualized metadata and 
markers that are completely distinct from the original clip that was imported into your project.

To duplicate one or more clips:
1 Select one or more clips to duplicate.

2 Do one of the following:

 – Choose Edit > Duplicate Clip

 – Hold the Option key down while dragging one or more selected clips to another bin

Adding Clips From the Timeline to the Media Pool
You can also drag one or more clips from the Timeline back into the Media Pool to create a 
duplicate. 

As with duplicating clips in the Media Pool, each duplicate is created as a new source clip that’s 
entirely separate from the original instance of that clip that was imported into DaVinci Resolve 
and is capable of storing individualized metadata and markers that are completely distinct from 
the original clip that was imported into your project. 

For example, the original clip in the Timeline remains conformed to the original clip that was first 
imported into the Media Pool; deleting the original clip from the Media Pool will make that clip 
“non-conformed” in the Timeline, while the duplicate you just created remains linked and 
available. If you’re in this situation, you can always turn Conform Lock Enabled off for that clip in 
the Timeline and reconform the Timeline Clip to the duplicate you just created, but that’s an 
extra step because the duplicate clip is considered by DaVinci Resolve to be a whole new 
piece of media that just happens to share the same clip details. 

This may seem strange, but there are a variety of finishing workflows that use this capability, so 
it’s good to know about.
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Duplicating Timelines
Timelines can be duplicated for a variety of reasons: to create a backup of a timeline at a 
specific date, to create a variation of an edit, or to create separately graded versions.

To duplicate a Timeline:
 � Select a Timeline in the Media Pool, and choose Edit > Duplicate Clip.

 � Press Command-4 to give focus to the Timeline, and choose Edit > Duplicate Timeline.

Choosing How to Display Bins
Once you’ve created a bin structure for your project, you can customize how your bins are 
displayed, depending on how you like to work.

Showing Bins in Separate Windows
If you right-click a bin in the Bin list, you can choose “Open As New Window” to open that bin 
into its own window. That window is basically its own Media Pool, complete with its own Bin list, 
Power Bins and Smart Bins lists, and display controls. This is most useful when you have two 
displays connected to your workstation, as you can drag these separate bins to the second 
display while DaVinci Resolve is in single screen mode. If you hide the Bin list, not only do you 
get more room for clips, but you also prevent accidentally switching bins if you really want to 
only view a particular bin’s contents in that window.

Multiple Media Pool bins opened as new windows

Using the Media Pool in Thumbnail View
If you work in Thumbnail view using the controls at the top right of the Media Pool, you have 
the option to resize the thumbnails to make them easier to see, and you can move the mouse 
pointer over each clip to hover scrub through its contents. Clicking any clip to select it displays 
it in the Media page Viewer. Whichever clip is currently selected is also output to video 
for monitoring.
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In Thumbnail view, you can use the Sort Order pop-up, at the top right of the Media Pool, 
between the Icon Size slider and the Icon/List view buttons, to choose how clips are sorted. 
There are fourteen options: File Name, Reel Name, Clip Name, Start TC, Duration, Type, FPS, 
Audio Ch, Flags, Date Modified, Date Created, Shot, Scene, and Take.

Working With Columns in List View
If you work in List view using the controls at the top right of the Media Pool, you gain additional 
organizational control by exposing columns that show the metadata that each clip contains, 
prior to media being added to your timeline. You can use these columns to help organize 
your media.

Methods of customizing metadata columns in List view:
 � To show or hide columns: Right-click at the top of any column in the Media Pool to 

reveal the column list, and while the column list is open, click the checkboxes of any 
columns you want to show or hide. Unchecked columns cannot be seen. When you’re 
finished, click anywhere else in the Media Pool to dismiss the column list.

 � To rearrange column order: Drag any column header to the left or right to rearrange 
the column order.

 � To resize any column: Drag the border between any two columns to the right or left to 
narrow or widen that column.

 � To sort by any column: Click the column header you want to sort with. Each additional 
time you click, the same header toggles that column between ascending and 
descending sort order.

Once you’ve customized a column layout that works for your particular purpose, you can save it 
for future recall. 

Methods of saving and using custom column layouts:
 � To create a column layout: Show, hide, resize, and rearrange the columns you need 

for a particular task, then right-click any column header in the Media Pool, and choose 
Create Column Layout. Enter a name in the Create Column Layout dialog, and click OK.

 � To recall a column layout: Right-click any column header in the Media Pool, choose the 
name of the column layout you want to use from the contextual menu, and choose Load 
from that item’s submenu. All custom column layouts appear at the top of the list.

 � To edit a column layout: Load the column layout you want to edit, make whatever 
changes you need to, then right-click any column header in the Media Pool, choose 
the name of the column layout you just edited from the contextual menu, and choose 
Update from that item’s submenu.

 � To delete a column layout: Right-click any column header in the Media Pool, choose 
the name of the column layout you want to delete from the contextual menu, and 
choose Delete from that item’s submenu.

While the available columns of metadata correspond to those fields shown in the Metadata 
Editor, the available columns in the Media Pool of the Media and Edit pages are a subset of the 
total amount of metadata that’s available, although they represent the most commonly used 
metadata you’ll find yourself referring to when editing and finishing. The available columns in 
List view include:
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File Name: The name of the file on disk that clip is linked to.

Clip Name: Editing the Clip Name lets you change the name with which clips appear throughout 
DaVinci Resolve when View > Use Clip Name for Clip Titles is enabled. By default, the clip name 
mirrors the source clip’s file name. When editing the clip name in the List view of the Media Pool, 
you can use “metadata variables” that you can add as graphical tags that let you reference clip 
metadata. For example, you could add the corresponding metadata variable tags 
%scene_%shot_%take and that clip would display “12_A_3” as its name if “scene 12,” “shot A,” 
“take 3” were its metadata. The clip name can also be edited in the Clip Attributes window. For 
more information on the use of variables, as well as a list of all variables that are available in 
DaVinci Resolve, see Chapter 144, “Using Variables and Keywords.”

Angle: An editable field to contain the angle of the media in a multi-camera shoot.

Audio Bit Depth: The bit depth of any audio channels in the media file.

Audio Ch: The total number of audio tracks in the media file.

Audio Codec: The specific codec used by the audio portion of the media file.

Audio Offset: Lists the audio offset, in frames, for clips that have been synchronized to separately 
recorded audio. This parameter is editable in the Media Pool.

Clip Color: The current color assigned to that clip. 

Bit Depth: The bit depth of the media file.

Comments: A user-editable field for entering information about that clip.

Data Level: The data level setting for the media file.

Date Created: The date the media file was created.

Date Modified: The last date the media file was modified.

Description: A user-editable field for entering information about that clip.

Duration: The total duration of the clip, in timecode.

End TC: The timecode value of the last frame in the media file.

End: The last frame number of the media file.

File Path: The file path where that media file is located on disk.

Flags: Which flags, if any, have been added to a media file.

Format: The image format used by that clip, such as QuickTime, MXF, WAVE, and so on.

FPS: The frame rate of the media file.

Frame/Field: Whether that media file is progressive or interlaced.

Frames: The total duration, in frames.

Good Take: An editable field to contain the circled state of media, relative to the script 
supervisor’s notes.

H-FLIP: Whether that media file is horizontally flipped in DaVinci Resolve.

HDRX: Only displayed for R3D media, indicates whether or not it’s HDRX media.

IDT: If ACES color science is selected in the Color Management panel of the Project Settings, the 
IDT used by that clip is listed here.
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In: The timecode value of the In point, if any, that’s stored for that clip.

Input Color Space: If Resolve Color Management is selected in the “Color Science” menu of the 
Color Management panel of the Project Settings, then this column will show the Input Color Space 
that has been assigned to each clip. By default, all clips inherit the Input Color Space setting that’s 
been selected in the Color Management panel of the Project Settings.

Input LUT: Which input Lookup table has been assigned, if any.

Input Sizing Preset: The currently selected Input Format Preset, if there is one.

Keyword: A user-editable field for entering searchable keywords pertaining to that clip. Only 
shows clip keywords, not marker keywords.

Offline Reference: Lists the offline reference video that has been assigned to a given timeline.

Optimized Media: Populated with the resolution of whatever optimized media you’ve created 
(Original, Half, Quarter, and so on). Clips that have not been optimized appear with “None.”

Out: The timecode value of the Out point, if any, that’s stored for that clip.

PAR: The pixel aspect ratio, if assigned.

Reel Name: The reel name of that clip. Dynamically generated by the “Assist using reel names 
from the” setting in the General Options panel of the Project Settings.

Resolution: The frame size of the media file.

Roll/Card: An editable field to contain the roll number of media that was scanned from film.

S3D Sync: Shows a frame count when you slip an eye to fix non-synced timecode using the “Slip 
Opposite Eye One Frame Left/Right” commands. This parameter is editable in the Media Pool.

Sample Rate: The sample rate of the media file’s audio, if there is any.

Scene: An editable field to contain the scene number of the media, relative to the script.

Shot: An editable field to contain the shot number of the media, relative to the scene.

Slate TC: The Slate timecode track used to sync audio with video.

Start KeyKode: The starting KeyKode value of a scanned negative.

Start TC: The timecode value of the first frame in the media file.

Start: The first frame number of the media file.

Take: An editable field to contain the take number of the media, relative to the shot.

Type: The type of item, such as Video+Audio, Video, Audio, Timeline, Multicam, Still, and so on.

Usage: After a Timeline has been created by importing an AAF, EDL, or XML project, you can 
right-click the Media Pool and choose “Update usage” to refresh the information shown in the 
Usage column to reflect how many times each clip is used in the project. This makes it easy to 
identify clips that aren’t in use, and which can be removed from the Media Pool.

V-FLIP: Whether that media file is vertically flipped in DaVinci Resolve.

Video Codec: The specific codec used by the video portion of the media file.

Chapter – 11 Adding and Organizing Media with the Media Pool 273



Finding Clips, Timelines, and Media
There are several ways to locate different items in the Media Pool and Media Storage, be they 
clips, timelines, or media on disk.

Finding Clips and/or Timelines Within the Media Pool
Clicking the magnifying glass button at the upper right-hand corner of the Media Pool exposes 
the Search Options, which can be used to locate one or more clips in the currently selected bin 
or bins, based on the metadata that’s selected in the Filter By pop-up menu to the left of it.

The Search Options pop-up menu (as 
seen in the Edit page Media Pool) lets you 
choose what metadata you’re searching

To find a clip in the Media Pool:
1 Select one or more bins in which to search. If you want to search the entire project, 

select all bins in the Bin list by selecting the top bin, then Shift-clicking the bottom bin 
to select all bins between.

2 (Optional) Choose a criteria from the Search Options pop-up menu at the top right 
of the Media Pool; you can choose All Fields to do a simultaneous search of every 
metadata column in the Media Pool at once, or you can choose a specific criteria to 
restrict your search. 

3 Type a search term in the Search field. As soon as you start typing, all clips that don’t 
match the search criteria are temporarily hidden. To show all clips in the Media Pool 
again, click the cancel button at the right of the search field.

Finding Timeline Clips in the Media Pool
If you have a clip in a timeline and you want to find the corresponding clip that it’s conformed to 
in the Media Pool, you can right-click that clip, and choose Find in Media Pool from the 
contextual menu.

Finding Timelines in the Media Pool
If you’d like to find the currently open timeline’s location in the Media Pool, you can choose 
Timeline > Find Current Timeline in Media Pool.
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Finding Media in the Media Storage Panel and Finder 
If you find yourself needing to determine the location of a clip’s source media file on disk, you 
can right-click an item in the Media Pool and choose Reveal in Media Storage panel. The 
Library automatically opens to the folder containing the media file you’ve selected, with that 
media file selected in the Library browser to the right.

Another feature that’s only available for macOS systems is the ability to right-click an item in the 
Media Pool and choose Reveal In Finder. A file system window opens up, revealing the media 
file that clip is linked to.

Going Immediately to a File System 
Location in the Media Browser
Conversely, if you drag a folder from the macOS Finder into the Media Storage panel, the Media 
Storage panel will immediately update to show the location of that folder.

Tracking Media Usage
As clips are added to timelines, two mechanisms come into play for keeping track of which clips 
are used in which timelines.

Thumbnail Clip Usage Indicators
Whenever you open a timeline, all thumbnails in the Media Pool automatically update to show 
highlighted usage bars to let you know which parts of that clip are used in that timeline.

Two colored highlights at the bottom of the 
thumbnail indicate which parts of a clip are 
used by the currently open timeline

If you right-click on a thumbnail that shows usage, a Usage submenu shows you a list of each 
instance of that clip in the currently open timeline. Choosing an instance from this list jumps the 
playhead to that clip in the Timeline.

List View Clip Usage Column
A Usage column can be optionally shown in the Media Pool while in List view. By default, this 
column is empty, but if you right-click in the Media Pool and choose the Update Usage 
command, the project is analyzed, and every use of that clip in every timeline of the entire 
project is logged in this column.
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A Usage column shows how many times a clip is 
used in every timeline, after analysis

Keep in mind that you must manually choose Update Usage every time you refer to this list if 
you want it to be up-to-date in the midst of ongoing editing.

Relinking Media Simply
DaVinci Resolve keeps track of the relationship between clips in your project and their 
corresponding source media on disk. If, for whatever reason, source media that links to clips in 
your project becomes unavailable, DaVinci Resolve has several different methods of relinking 
those clips in the Media Pool.

This section summarizes the top two methods of relinking. For more comprehensive information 
on conforming projects and relinking media, see Chapter 39, “Conforming and Relinking Clips.”

Relink Selected Clips
The easiest method of relinking clips in your project that have gone offline is to use the 
appropriately named “Relink selected clips” command. This is the most flexible method of 
relinking clips in your project with clips in a file system directory of your choice, using file name 
and timecode as the primary criteria for drawing a correspondence between each clip and the 
corresponding media file on disk. When you relink clips this way, the original file path in 
DaVinci Resolve is ignored, so this is a good command to use to relink to media that’s been 
reorganized on disk.

To relink selected clips:
1 Do one of the following:

 – Select one or more clips in the Media Pool browser that you want to relink, then 
right-click one of the selected clips or the selected bin, and choose “Relink Clips for 
Selected Bin” from the contextual menu.

 – Select a bin in the Media Pool Bin list that contains clips you want to relink, then 
right-click one of the selected clips or the selected bin, and choose “Relink Selected 
Clips” from the contextual menu.

Chapter – 11 Adding and Organizing Media with the Media Pool 276



2 When the Relink File dialog opens, choose a directory in which to look for the files 
you want to relink to, and click OK. DaVinci Resolve attempts to find every clip with a 
matching file name in the subdirectories of the directory you chose, using the original 
file paths of the clips being relinked to do this as quickly as possible. By first looking for 
the clips in the directories they were originally in, relinking can be quite fast.

3 If there are any clips that couldn’t be found using the method in step 2, you’re 
prompted with the option to do a “deep search” by a second dialog. If you click Yes, 
then DaVinci Resolve will look for each clip inside every subdirectory of the directory 
you selected in step 2. This may take significantly longer, but it should be completely 
successful so long as the media that’s required is within the selected directory 
structure.

4 If there are still other clips that couldn’t be found, you’re prompted to either choose 
another directory altogether to continue searching, or quit.

Change Source Folder
If you’ve used your file system to move media that’s associated with a DaVinci Resolve project, 
but you haven’t changed the directory structure with which it’s organized, you can use the 
Change Source Folder command to quickly relink selected clips in the Media Pool to the new 
file path of the media on disk, using the original file paths as a guide. This is a good relinking 
method to use, if possible, for projects on a SAN where you don’t want to risk the excessively 
long search times that could result from using the Relink command to examine a nested 
hierarchy of folders in a more flexible way.

To relink your Media Pool clips to a new location:
1 Select one or more clips in the Media Pool, then right-click one of the selected clips, 

and choose Change Source Folder from the contextual menu. The Relink Media 
window appears displaying the original path for the material, with controls for choosing 
a new directory.

2 Click the “…” button to the right of the Change To field, and then use the file navigation 
dialog to find the new location of the media file, select it, and click Open.

3 If you succeeded in finding the appropriate media file, click Change. Otherwise, click 
Cancel.
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Chapter 12

Using Clip 
Metadata

DaVinci Resolve has powerful tools for viewing, editing, exporting, and 
importing metadata associated with each clip in the Media Pool. Once 
your metadata house is in order, you can use this metadata in the Edit, 
Color, and Audio pages to find, sort, and organize the clips in your project, 
so you can work faster.
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Editing Clip Metadata
Whether you’ve imported media in preparation for editing, or you’ve imported a project for 
grading that resulted in media being imported automatically, once you’ve added clips to the 
Media Pool, it would behoove you to consider taking the time to review and add metadata to 
your clips. 

At the very least, it would be valuable for you to use the Metadata Editor that’s available in 
either the Media page or the Edit page to add information to each clip such as a Description, 
Shot and Scene designations, Take information, and possibly some useful keywords such as 
Character Names, Shot Framing, Interior or Exterior keywords, and so on. If you’re especially 
ambitious (or you have a very responsible assistant), you could go further and add Shoot Day, 
Camera Type, Audio Notes, and other valuable information. Much of the metadata that is useful 
in the day to day work of editing and grading can be found in the Shot & Scene group, but there 
are many other potentially useful groups as well that you should explore.

Keep in mind that the more metadata you associate with each clip, the more methods you have 
at your disposal for creating custom Smart Bins (for editing) and Smart Filters (for grading) with 
which to zero in on the clips you need for any given situation. This will not only make it easier to 
find what you need, but it’ll help you to work faster.

For example, if you’ve entered enough metadata, then you can create multi-criteria Smart Bins 
or Smart Filters that let you find the equivalent of “every close-up of Sally inside the diner,” or 
“every long shot of Antonio outside in the parking lot.” In a documentary, you could easily 
isolate “every interview shot of Louis from camera 1,” or “every B-roll clip with Robyn.” All of this 
will help you to find media faster for editing, or to quickly isolate similar clips that you need to 
match together for grading.

Using the Metadata Editor
Whenever you select a clip in the Media Pool, its editable metadata appears in the 
appropriately named Metadata Editor (so long as it’s displayed). You can use this editor to 
further massage the metadata of the clips in a project, adding information on set that will be of 
help later during editing and finishing. 

By default, clips initially appear with a set of clip metadata called “Clip Details,” that shows some 
of the most fundamental details of the clip such as start and end timecode, duration, bit depth, 
and so on.

Because there are so very many metadata fields that are available, two pop-up menus at the 
top right of the Metadata Editor let you change which set of metadata is displayed.

 � Metadata Presets (to the left): If you’ve used the Metadata panel of the User 
Preferences to create your own custom sets of metadata, you can use this pop-up to 
choose which one to expose. Surprisingly enough, this is set to “Default” by default.

 � Metadata Groups (to the right): This pop-up menu lets you switch among the various 
groups of metadata that are available, grouped for specific tasks or workflows.
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Metadata categories pop-up menu

If you want to see a list of every piece of metadata in a clip, you can choose All Groups. 
Otherwise, you can choose any set of metadata to narrow your focus to just those items of 
information.

To edit metadata for a single clip:
Select any clip in the Media Pool, and edit whatever metadata fields you require. The 
edited metadata is immediately saved.

To edit metadata for multiple clips:
1 Choose a metadata set using the pop-up menu in the Metadata Editor.

2 Select multiple clips in the Media Pool by Shift-clicking, Command-clicking, or dragging 
a bounding box around them.

3 Edit whichever metadata fields you want to. Checkboxes are automatically turned on 
for any metadata fields you edit.

4 When you’re done, always click the Save button at the bottom of the Metadata Editor. 
When you edit metadata for multiple clips at once, it’s not automatically saved if you 
create a new selection in the Media Pool without clicking the Save button first.
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Editing Keywords
While most metadata in the Metadata Editor is edited via text fields, checkboxes, or multiple 
button selections (such as Flags and Clip Color), the Keyword field is unique in that it uses a 
graphical “tag” based method of data entry. The purpose of this is to facilitate consistency with 
keyword spelling by making it easy to reference both a built-in list of standardized keywords, as 
well as other keywords that you’ve already entered to other clips.

Once added, keywords are incredibly useful for facilitating searching and sorting in the Media 
Pool, for creating Smart Bins in the Media and Edit pages, and for use in Smart Filters on the 
Color page. Reaping these benefits by adding and editing keywords is simple, and works 
similarly to the method of entering metadata variables that’s described in Chapter 144, “Using 
Variables and Keywords.”

To add a keyword:
1 Select the Keyword field of the Metadata Editor, and begin typing the keyword you 

want to use. As you begin typing, a scrolling list appears showing all keywords that are 
available using the string of characters you’ve just typed.

2 To find a specific keyword in the list, start typing that keyword’s name and this list 
automatically filters itself to show only keywords that contain the characters you’ve just 
typed. Choose which keyword you want to use in the list using the Up and Down Arrow 
keys, and press Return to choose that keyword to add.

The keyword list that appears when you type within the Keyword field

As soon as you add one or more keywords, they appear as a graphical tag. To re-edit 
any keyword, simply click anywhere within the Keyword field to edit it.

To edit a keyword:
Double-click any keyword to make it editable, then edit it as you would any other piece 
of text, and press Return to make it a graphical keyword tag again.

To remove a keyword:
Click any keyword to select it, and press Delete.
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Tips for Editing Metadata

Editing metadata is like taking vitamins. Nobody wants to, but you know you probably 
should. To encourage you to undertake this task so you can reap the benefits, here 
are a few pointers.

• Don’t start editing until you review your footage and add metadata. If you get into the 
habit of entering your clip metadata before you get preoccupied with your edit, you’ll 
be in a much better position to edit faster using organizational tools that leverage the 
metadata you’ve entered.

• Enter metadata starting with groups of clips and then moving to individual clips. 
Since the Metadata Editor lets you add metadata for multiple selected clips at once, 
it becomes easy to select groups of clips based on their thumbnails for entering 
information such as Scene designations, Interior or Exterior keywords, Character 
keywords, and Framing keywords. You’ll be surprised how fast this goes, and how 
useful this information is later on, for both editing and grading.

• After you’ve entered all the metadata you can in groups of clips, then switch to 
entering clip-specific metadata such as Shot designations, Take numbers, 
descriptions of action, and other clip-specific keywords.

• There’s no right or wrong way to edit or use metadata, but a lack of consistency will 
make it less useful. For example, if you’re identifying each clip that takes place at the 
same diner, try to use the same keyword or descriptive text. If you call half the shots 
“diner” and the other half “restaurant,” your ability to easily search for all the diner 
shots will be compromised.

Creating Custom Metadata Groups
The Metadata panel in the User Preferences lets you create custom sets of metadata 
parameters that will be exposed in the Metadata Editor. Using this panel, you can create 
customized subsets of metadata that are focused on your particular needs. 

Presets that you create are available from the Option menu that’s just to the left of the Metadata 
categories pop-up menu. 

Custom metadata categories pop-up menu

Choose any custom preset to restrict the Metadata Editor to only showing the metadata fields in 
that preset. To see the full set of custom metadata fields you’ve saved to a particular preset, you 
should set the Metadata Categories pop-up menu to All Groups. To make the full set of 
metadata fields reappear, just choose default presets in the same pop-up.
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Making and managing metadata presets is simple.

To create a new metadata preset:
1 Open the Metadata panel of the User pane of the Preferences window, and click New.

2 Click the checkboxes of every metadata tag you want to include in this preset, or click 
the checkbox of a group name on the list to include all metadata tags within it.

Every single metadata tag available in DaVinci Resolve appears within one of several 
groups that appear as a list. To open any group to see its contents, move the pointer 
over that group’s entry on the list, and click the Open button when it appears.

3 When you’re finished, click the Save button.

To edit an existing metadata preset:
1 Select a preset from the list, and click Edit.

2 Turn checkboxes on and off to include or exclude whatever tags you need.

3 Click the Save button.

To delete a metadata preset:
Select a preset from the list and click Delete.

Importing and Exporting 
Media Pool Metadata
Once you’ve taken the trouble to add metadata to the clips in your project, DaVinci Resolve 
makes it possible to export metadata from the Media Pool of one project for import into the 
clips of another project, for instances where you need to move metadata around. 

For example, a DIT might have entered a lot of metadata to the DaVinci Resolve project used 
for generating dailies, but then an impatient editor might have created a separate project to 
begin editing those dailies. Instead of requiring the editor to enter each clip’s metadata all over 
again, you can export the metadata from the DIT’s project and import it into the editor’s new 
project, automatically matching the relevant metadata to each corresponding clip.

To export Media Pool metadata:
1 Open a project containing Media Pool metadata you want to export.

2 Optionally, select which clips in the Media Pool you want to export metadata for.

3 Choose File > Export Metadata From > Media Pool to export metadata from every clip 
in the Media Pool, or choose File > Export Metadata From > Selected Clips to only 
export metadata from clips you selected in step 2.

4 When the Export Metadata dialog appears, enter a name and choose a location for the 
file to be written, then click Save. All metadata is exported into a .csv file that can be 
viewed and/or edited in any spreadsheet application.

If you open the resulting metadata .csv file, the first line is a header that lists what metadata is to 
be found for each item listed in this document, and in what order. Only metadata fields that 
have been populated for at least one clip are exported and listed in this header; unused 
metadata fields in the Metadata Editor or Media Pool are ignored. 

This file can now be imported into another project file to reattach the metadata to the 
same clips.
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To import Media Pool metadata:
1 Open a project containing clips you want to populate with imported metadata.

2 Optionally, select which clips in the Media Pool you want to import metadata to.

3 Choose File > Import Metadata To > Media Pool to import metadata to potentially every 
clip in the Media Pool, or choose File > Import Metadata To > Selected Clips to only 
import metadata to clips you selected in step 2.

4 When the Import Metadata dialog appears, choose a metadata .csv file to import, 
and click Open.

5 When the Metadata Import dialog appears, choose the Import Options you want to 
use to match the .csv file’s metadata to the correct clips in the currently open project. 
By default, DaVinci Resolve tries to use “Match using filename” and “Match using clip 
start and end Timecode” to match each line of metadata in the .csv file with a clip in the 
Media Pool, but there are other options you can use such as ignoring file extensions, 
using Reel Name, and using source file paths.

6 Next, choose which Merge Option you want to use in the Metadata Import dialog. 
There are three options:

 – Only update metadata items with entries in the source file:  The default setting. 
Only updates a clip’s metadata if there’s a valid entry in the imported .csv file. Other 
clip metadata fields are left as they were before the import.

 – Update all metadata fields available in the source file:  For each clip that 
corresponds to a line of metadata in the imported .csv file, every single metadata 
field referenced by the .csv file is overwritten, regardless of whether or not there’s a 
valid entry for that field.

 – Update all metadata fields available in the source file and clear others:  For each 
clip that corresponds to a line of metadata in the imported .csv file, every single 
metadata field referenced by the .csv file is overwritten, regardless of whether or not 
there’s a valid entry for that field. Furthermore, metadata fields that aren’t referenced 
by the imported .csv file are cleared of whatever metadata was there before.

The Metadata Import dialog that lets you choose options 
for how to match and merge imported metadata

7 When you’re finished choosing options, click Ok and all available metadata from the 
source .csv file will be imported.
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Different Ways of Using Clip Metadata
To encourage you to take advantage of the clip metadata tools that exist in DaVinci Resolve, 
here’s a short list of the many different ways you can use clip metadata to help you work faster.

 � Searching for clips in the Media Pool

 � Searching for clips in the Timeline

 � Sorting the Media Pool by metadata columns in list view

 � Creating Smart Bins in the Edit page

 � Creating Timeline Filters in the Color page

 � Using Metadata to create clip Clip Names

 � Displaying Metadata in frame using the Color page Burn In palette

Renaming Clips Using Clip Names
The most fundamental piece of clip metadata is each clip’s name, which is used to identify clips 
nearly everywhere they appear inside DaVinci Resolve. By default, clips show the file name of 
the corresponding media file on disk. Since the dawn of tapeless recording, however, editors 
have been stuck with camera original media having names that are not exactly “human 
readable.” 

Fortunately, you have the option of entering a more user-friendly clip name to use instead, while 
preserving the original file name that’s critical for maintaining the link between a clip and its 
media, as well as for tracking an offline clip’s corresponding link to the online media from which 
it originated. There are a few ways you can edit the clip name of a clip.

NOTE: You can also edit the clip names of timelines, compound clips, and multicam 
clips, so that you can have two sets of naming conventions for these items, one for 
when you’re doing creative editing, and one for when you’re doing finishing tasks.

To edit a clip’s clip name, do one of the following:
 � In the Media Pool’s Icon view, click a clip’s name once, pause a moment, then click 

a second time to select the name, type a new name, then press return to accept the 
name.

 � In the Media Pool’s List view, show the Clip Name column (hidden by default). By 
default, the Clip Name mirrors the source clip’s file name, but you can click the Clip 
Name column for any clip to add a new name from scratch.

 � With the Clip Name column exposed in the Media Pool’s List view, Option-click the Clip 
Name column for any clip to edit the file name, rather than entering a brand new name.

 � To edit the clip name of multiple clips, select all of the clips for which you want to 
change the clip name, then right-click one of the selected clips and choose Clip 
Attributes. Open the Name panel of the Clip Attributes window, edit the Clip Name 
field, and click OK.
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After you’ve changed a clip’s clip name, that clip appears in the following places using the clip 
name instead of the original file name:

 � The Media Pool’s Thumbnail view

 � The name bar of each clip in the Timeline

 � The Source Viewer title bar

 � The Clip Name field of the Clip Attributes dialog’s Name panel

Switching Between File Names and Clip Names
Since different tasks require different information, you have the ability to switch between using 
clip file names and clip names. For example, finishing editors will probably have more reason to 
refer to the file name of each clip, making it easier to troubleshoot problems with reconforming 
and relinking. Creative editors, on the other hand, will want to use easier-to-read clip names to 
make it easier to find what they need.

To switch between file names and clip names:
Choose View > Show File Names to toggle between both naming conventions.

Using Metadata to Define Clip Names
If you’re an enthusiastic user of clip metadata (and you should be), you can use “metadata 
variables” that you can add into a field that let you reference other metadata for that clip. For 
example, you could add the combination of variables and text seen in the following screenshot 
to define a clip name automatically. Variables, once they’ve been entered, are represented as 
graphical tags shown with a background, while regular text characters that you enter appear 
before and after these tags.

Variables and text characters entered to create a clip name based on a clip’s metadata

As a result, that clip would display “12_A_3” as its name if scene “12,” shot “A,” and take “3” 
were its metadata. When you do this, you can freely mix metadata variables with other 
characters (the underscore, as in the example above) to help format the metadata to make it 
even more readable. 

Every single item of metadata that’s available in the Metadata Editor can be used as a variable, 
and several other clip and timeline properties such as the version name of a clip’s grade, a clip’s 
EDL event number, and that clip’s timeline index number can be also referenced via variables. 

Since the use of metadata variables is a great way to automatically generate names for multiple 
clips, you may find it more useful to add metadata variable-driven clip names by selecting all of 
the clips you want to edit, and opening the Clip Attributes window. By editing the Clip Name 
field found in the Name panel, you can add a single clip name to all selected clips at once.
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To add a variable to a text field that supports the use of variables:
1 Type the percentage sign (%) and a scrolling list appears showing all 

variables that are available. 

2 To find a specific variable quickly, start typing the characters of that variable’s name 
and this list automatically filters itself to show only variables that contain the characters 
you’ve just typed. 

3 Choose which variable you want to use using the Up and Down Arrow keys, and press 
Return to choose that variable to add.

The variable list that appears when you type the % character

As soon as you add one or more metadata variables to a clip’s Clip Name column and press 
Return, the string is replaced by its corresponding text. To re-edit the metadata string, simply 
click within that column, and the metadata variables will reappear. Be aware that, for clips where 
a referenced metadata field is blank, no characters appear for that corresponding metadata 
variable in the Clip Name column.

To remove a metadata variable:
Click within a field using variables to begin editing it, click a variable to select it, and 
press Delete.

For more information on the use of variables, as well as a list of all variables that are available in 
DaVinci Resolve, see Chapter 144, “Using Variables and Keywords.”
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Chapter 13

Syncing 
Audio and Video

When you’re working on a program where the production audio was 
recorded separately from the production video (often referred to as 
“dual-system recording), DaVinci Resolve provides tools for syncing the 
audio and video together in a variety of ways to create media that you can 
edit easily. The process of syncing audio and video together is often 
referred to as “syncing dailies.”
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Syncing Audio to Video
If you’re processing dailies for a shoot that used dual-system recording, where audio is 
recorded to a separate device than video, you can “sync the dailies” in DaVinci Resolve in one 
of two ways. Synced clips can be output as media files with embedded audio or output to tape, 
whatever your client requires.

Syncing Audio to Video Using Timecode
Ideally, if the sound recordist on set was highly organized, and the camera and audio recorder 
both used synchronized timecode, you can use a single command to automatically sync every 
clip in a timeline to a bin of Broadcast .wav files that have matching timecode.

To batch sync audio to video using timecode:
1 Create a new project, open to the Media page by default, and import the video media 

you need to sync into any bin of the Media Pool.

2 Import the matching Broadcast .wav files into the same bin as the accompanying 
video media you imported in step 1. If you want to stay more organized, you can create 
another bin to contain the audio clips, but it must be inside the bin that contains the 
video files. The audio bin can be named anything you like.

Organizing production audio in a bin created within the 
accompanying camera media bin

3 Right-click the bin containing the matching audio and video clips, and choose one of 
the following commands from the contextual menu:

 – Auto-Sync Audio Based on Timecode: Replaces each video clip’s previous audio 
channels with audio channels from the newly synced .wav files.

 – Auto-Sync Audio Based on Timecode and Append Tracks: Adds new channels 
in addition to the audio channels that were previously in the media file. The newly 
synced channels are added to an additional track, so when edited into the Timeline, 
a clip that’s synced this way appears with one video clip and two audio clips 
that occupy two different audio tracks, so you can edit the camera original audio 
independently from the synced audio.

Every clip in the selected bin for which there was an accompanying Broadcast .wav file with 
matching timecode is immediately synced with an audio track. All synced clips appear with an 
audio icon at the bottom left in the Media Pool when Thumbnail view is selected. Now that the 
clips are synced, you can edit them in the Edit page or use the Deliver page to export offline 
dailies or online media with embedded sync audio for use in other applications.
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Syncing Audio to Video 
by Matching Waveforms
If you don’t have matching timecode in the audio and video source clips you’re syncing, but you 
had the foresight to record camera audio at the same time as the dual source production audio 
you want to sync to, DaVinci Resolve can use waveform syncing to compare the audio 
waveforms of your audio and video source files, and sync the ones that match.

To batch sync dailies using waveform syncing:
1 Create a new project, open to the Media page by default, and import both the video 

and audio media you need to sync. There’s no need to organize your files in any 
particular way, but it’s not a bad idea, on multi-day shoots, to organize the audio and 
video files so that it’s easy to select all of a single day’s clips at once so that you can 
sync your files in smaller batches. Even organizing your clips by scene can make 
waveform syncing go faster by reducing the number of files that need to be compared 
at once.

2 If you’ve placed the audio and video into separate bins, then you can Command-click 
both bins in the bin list to select them and expose all of their contents in the Media 
Pool. If you placed your media in the same bin, this is not necessary.

3 Select one of the exposed clips in the Media Pool, and press Command-A to select all 
audio and video clips you want to sync.

4 Right-click one of the selected clips, and choose one of the following commands from 
the contextual menu:

 – Sync Video and Audio Clips: Analyzes and compares the waveforms of each of 
the selected clips, and replaces each video clip’s previous audio channels with the 
newly synced .wav files.

 – Sync Video and Audio Clips and Append Tracks: Adds new channels in addition 
to the audio channels that were previously in the media file. The newly waveform-
synced channels are added to an additional track, so when edited into the Timeline, 
a clip that’s synced this way appears with one video clip and two audio clips 
that occupy two different audio tracks, so you can edit the camera original audio 
independently from the synced audio.

A progress bar dialog appears, showing you how long the syncing operation will take. 
When it’s complete, your clips will be synced.

Progress dialog for syncing dialog using waveforms

TIP: After syncing, you may be notified via a dialog that one or more clips could not be 
synced. Note these clips, as it may be possible to use waveform syncing more 
successfully on just the selected pair of audio and video items that belong together.
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Manually Syncing Audio to Video
If you have a collection of WAV or AIFF audio files with video source media that lacks matching 
timecode, you need to manually sync each pair of media files together, one-by-one, using a 
sync reference such as the clap of a clapperboard or any other sharp sound with a distinct 
audio/visual correspondence.

To manually sync audio to video:
1 Create a new project, and import the video media you need to sync into the Media 

Pool. If a dialog appears asking whether or not you want to update the project to match 
the media, click OK.

2 If you want to stay organized, create a second bin in the Media Pool, named Audio 
Clips, and import the matching Broadcast .wav files into it. The name of the bin is not 
important, and having all the audio in one bin is simply a matter of convenience.

3 Click the Waveform button at the top of the Audio Panel, which lets you view and scrub 
along the waveform of audio clips you select in the Media Pool.

4 Select a video clip to sync, and move the Viewer playhead to line up with the first visual 
sync point in the first clip. This could be the clap of a clapperboard, the red flash of 
a tablet computer’s slate app, a hand clap, or any clear visual cue to which there is a 
corresponding audible sound.

5 Now, select whichever audio clip corresponds to the current video clip in the Viewer, to 
open its waveform into the Audio Panel.

6 Use the Audio Panel transport controls and scrubber bar in the Source Viewer to move 
the playhead to the audio sync point that corresponds to that video sync point. This 
may be a clap, a beep, or some other staccato sound that’s easy to sync to. As you play 
through the clip, the bottom half of the Viewer shows a zoomed out waveform for the 
entire clip, while the top half of the Viewer shows a zoomed in section of the waveform 
that immediately surrounds the playhead. Hopefully, the sync point you’re looking for is 
a distinct, loud spike somewhere towards the beginning or the end (in the case of a tail 
slate) of the audio clip.

Aligning video and audio sync points with the Audio Panel set to show the Waveform panel

7 When you’ve found the audio sync point that matches the video sync point, click the 
Link/Unlink Audio button at the bottom right of the Audio Panel to embed the now 
synced audio into the video clip.
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Clicking the sync link button to lock sync

The audio and video items are linked. At this point, you can use the newly synced clips 
in the Edit page, and use the Deliver page to export offline or online media with 
embedded audio for editing.

Offsetting the Sync of 
Previously Synced Clips
If you need to offset the audio (or stereo 3D) sync of the items that make up a clip later on, you 
need only select the synced clip you want to resync in the Media Pool, then click the 
Waveform button at the top of the Audio panel to show the clip’s audio waveform, turn off the 
linked clip button, change either the audio or video sync points, and turn the linked clip button 
back on again. 

You can also use two sets of commands for slipping the sync of any clip:

 � Trim > Slip Audio > Slip Audio One Frame Forward/Reverse: (Option-Period and 
Option-Comma) Slips the audio/video sync of any clip in whole frame increments.

 � Trim > Slip Audio > Slip Audio One Subframe Forward/Reverse: (Option-Right 
Arrow and Option-Left Arrow) Slips the audio/video sync of any clip in 1/10th frame 
increments.

 � Trim > Slip Eye > Slip Eye One Frame Forward/Reverse: (Command-Option-Period 
and Command-Option-Comma) Slips the sync relationship between the eyes within 
a stereo clip in whole frame increments.

Finding Synced Audio Files
When you’ve synced dual-system audio and video clips together in DaVinci Resolve, you can 
find the audio clip that a video clip has been synced to using the following procedure.

To find the audio clip that a video clip has been synced to:
 � Right-click a video clip that’s been synced to audio, and choose “Reveal synced audio 

in Media Pool” from the contextual menu. The bin holding the synced audio clip is 
opened and that clip is selected.
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Chapter 14

Modifying Clips 
and Clip Attributes

Once you’ve added clips to the Media Pool, you may find you have to 
make some changes to prepare it for use in your project. This chapter 
covers diverse tasks that include redefining the clip attributes associated 
with each source clip to reinterpret video and audio attributes, timecode 
values, and clip names, converting LTC timecode recorded on an audio 
track into usable timecode, chopping long clips into more manageable 
subclips, and creating stereo clips from left and right eye media.
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Changing Clip Attributes
Using the Clip Attributes window, you can alter additional attributes for multiple clips all at once. 
This window has some overlap with other clip attributes that are editable directly from 
submenus within the Media Pool clip contextual menu.

To edit the attributes of one or more clips in the Media Pool:
1 Select one or more clips in the Media Pool by Shift-clicking, Command-clicking, or 

dragging a bounding box around them.

2 Right-click one of the selected clips, and choose Clip Attributes.

3 Click to open the panel of the attributes you want to edit. If you’ve selected multiple 
clips, then making your alterations automatically checks the box of the attributes 
being changed.

4 When you’re finished, click OK to accept the changes.

Starting in DaVinci Resolve 12.5, you can also edit select clip attributes for clips that have been 
edited into the Timeline.

To edit the attributes of one or more clips in the Timeline:
1 Select one or more clips in the Timeline by Shift-clicking, Command-clicking, or 

dragging a bounding box around them.

2 Right-click one of the selected clips, and choose Clip Attributes.

3 Click to open the panel of the attributes you want to edit. If you’ve selected multiple 
clips, then making your alterations automatically checks the box of the attributes being 
changed.

4 When you’re finished, click OK to accept the changes.

Video Attributes
These affect individual clip frame rate, geometry, and data levels.

The Video panel of the Clip Attributes Window
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 � Video Frame Rate: In cases where a clip’s frame rate was specified incorrectly by 
another application or recording device, or if there is no frame rate metadata available 
at all, you can change what DaVinci Resolve considers the frame rate of the source clip 
to be by either using this menu to choose a frame rate from 1 to 120 fps, or choosing 
Custom and entering a value from 1 to 32,000 fps (to accommodate high-speed and 
specialty format video). Changing a clip’s Video Frame Rate will change its duration and 
relative playback speed in DaVinci Resolve. A clip’s audio, however, will be unaffected. 
Please note, just because extremely high frame rate media is supported, do not 
expect real time performance at excessively high frame rates, and understand that 
what performance your workstation is capable of depends on its configuration and the 
speed of your storage.

 � Data Levels: In certain circumstances, you may find that you need to manually choose 
appropriate data levels for clips that are not being interpreted correctly, choosing 
between Auto, Video, and Full. For more information on this setting, and how it affects the 
image data in your project, see Chapter 7, “Data Levels, Color Management, and ACES.”

 � Pixel Aspect Ratio: In projects using a mix of media with different frame sizes, you can 
assign specific pixel aspect ratios using this pop-up menu.

 � Horizontal and Vertical Image Flip: Modifies the horizontal and vertical image flip 
camera metadata for r3d clips, which is useful for stereoscopic 3D projects shot with a 
mirrored camera rig that reverses the media from one eye, or in cases where steadicam 
rigs result in upside-down clips. These settings are different from the Flip Image 
controls in the Sizing palette of the Color page.

 � Input Sizing Preset: You can use this panel to assign a Sizing palette preset to select 
clips. For example, if you have a special Input Format Preset for standard definition 
PAL widescreen clips that you’ve edited into a high definition project, you can do a sort 
in the Media Pool to isolate them, and then select them all and apply this preset.

 � Field Dominance: By default, the Auto setting enables DaVinci Resolve to automatically 
determine whether a particular clip is Upper- or Lower-field dominant. If this automatic 
determination is wrong, you can choose Upper or Lower to manually override this.

 � Enable Deinterlacing: (only available in Studio version) This checkbox is only enabled 
if “Enable video field processing” is turned off in the Master Settings panel of the 
Project Settings. Turning the Enable Deinterlacing checkbox on sets DaVinci Resolve 
to deinterlace clips using the Deinterlace quality setting that’s located in the Image 
Scaling panel of the Project Settings. Normal is a high-quality deinterlacing method 
that is suitable for most clips, while High is a more processor-intensive method that can 
sometimes yield better results, depending on the footage.

 � Alpha Mode: The options presented here depend on the format of the clip you’ve 
selected, since only certain formats (such as ProRes 4444, QuickTime Animation, 
OpenEXR, TIFF sequences, and so on) are capable of containing alpha channels. 
If you’ve imported clips with embedded alpha channels, this panel lets you enable 
or disable their use in DaVinci Resolve (by choosing None), choose the type of alpha 
channel (Premultiplied or Straight), or invert the alpha channel. If you select a clip that 
doesn’t contain an alpha channel, then most of these options don’t appear.

The Alpha Mode options that are available 
when a clip has an embedded alpha channel
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 � Super Scale High Quality Upscaling: For instances when you need higher-quality 
upscaling than the standard Resize Filters allow, you can now enable one of three 
“Super Scale” options in the Video panel of the Clip Attributes window for one or more 
selected clips. Unlike using one of the numerous scaling options in the Edit, Fusion, 
or Color pages, Super Scale actually increases the source resolution of the clip being 
processed, which means that clip will have more pixels than it did before and will be 
more processor-intensive to work with than before unless you optimize the clip (which 
bakes in the Super Scale effect into the optimized media), or cache the clip in some way.

The Super Scale pop-up menu provides three options of 2x, 3x, and 4x, as well as 
Sharpness and Noise Reduction options to tune the quality of the scaled result. Note 
that all of the Super Scale parameters are in fixed increments; you cannot apply Super 
Scale in variable amounts. Selecting one of these options enables DaVinci Resolve to 
use advanced algorithms to improve the appearance of image detail when enlarging 
clips by a significant amount, such as when editing SD archival media into a UHD 
timeline, or when you find it necessary to enlarge a clip past its native resolution in 
order to create a closeup.

You may find that, depending on the source media you’re working with, setting 
Sharpness to Medium yields a relatively subtle result that can be hard to notice, but 
setting Sharpness to high should be immediately more preferable, while also 
sharpening grain and noise in the image to an undesirable extent at the default 
settings. However, while raising Noise Reduction will ameliorate this effect, it will also 
diminish the gains you obtained by raising Sharpness. In these cases, it’s worth 
experimenting with keeping Sharpness at Low or Medium so that Super Scale sharpens 
all aspects of a clip, but then using the Noise Reduction tools of the Color page (with 
their additional ability to be fine-tuned) to diminish the unwanted noise.

Super Scale options in the Video panel of the Clip Attributes window

TIP: Super Scale, while incredibly useful, is an extremely processor-intensive 
operation, so be aware that turning this on will likely prevent real-time playback. One 
way to get around this is to create a string-out of all of the source media you’ll need to 
enlarge at high quality, turn on Super Scale for all of them, and then render that 
timeline as individual clips, while turning on the “Render at source resolution” and 
“Filename uses > Source Name” options.
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Audio Attributes
The Audio panel lets you alter the channel format and channel assignments for one or more 
clips. These settings affect what appears in the audio tracks of the Timeline when you edit a 
clip into a program. When you first import clips into the Media Pool, you can use the Audio 
Attributes panel to define which embedded audio channels can be exposed as tracks in the 
Edit and Fairlight page timelines for editing, and how they will appear.

The Audio panel of the Clip Attributes window

Add Track Controls
A set of controls at the top of the Track/Channel list lets you add additional tracks to a clip. 
Adding additional tracks to a clip lets you remap that clip’s available channels to appear in the 
Timeline when you edit it.

 � Format: A pop-up that lets you choose a format for new tracks that you add. The setting 
you choose here affects how many channels appear in the Channel Assignments 
list below, as well as what kind of Timeline audio track will be required to expose all 
channels of that clip. If you choose a Channel Format with fewer channels than are 
embedded in a clip, all extraneous channels will be disabled. The available options are:

 – Mono: Appropriate for single-channel clips

 – Stereo: Appropriate for clips with two-channel left/right audio

 – 5.1: Appropriate for 5.1 surround mixes

 – 7.1: Appropriate for 7.1 surround mixes

 � Adaptive: Appropriate for multiple-mono production audio, such as multi-channel 
recordings where a boom microphone, two separate lavaliere microphones, and a 
mixdown track are recorded simultaneously.

Chapter – 14 Modifying Clips and Clip Attributes 300



 � Tracks: Lets you adjust how many tracks you want to add to the current clip or clips. 
Each track you add will result in an additional linked audio item being edited into an 
additional audio track when this clip is edited into the Timeline. For example, if you 
have a multi-channel production recording with four different microphones, you can 
add 3 mono audio tracks, and then assign each channel to a separate track to expose 
each channel as an individual audio clip in the Timeline for purposes of editing each 
microphone separately.

 � Add button: Lets you add the tracks you’ve specified to the current clip or clips.

A clip with a single track of two-channel stereo audio at left, compared 
to a clip with two tracks of single channel mono audio at right

Audio Track and Channel List
The list below the Add Track controls show an entry for each track defined within the currently 
selected clip or clips. Pop-ups within this list let you redefine and map how that clip’s channels 
are spread across the differently mapped tracks you’ve created.

 � Format: The format of each audio track. Can be Mono, Stereo, 5.1, 7.1, or Adaptive.

 � Source Channel: Each track lists however many channels the specified format requires. 
A Stereo track has two source channels, a 7.1 track has eight source channels. Channels 
appear hierarchically underneath the track they belong to.

 � Track: The name of each track in a clip.

 � Channel in Track: The name of each channel in that track.

 � Delete Track button: Hovering the pointer over a track reveals a trashcan icon you can 
click to delete that track.

A trashcan button you can use to delete an audio track within Clip 
Attributes; it only appears when you hover the mouse over a track

Support for Mixed Audio Track Formats from Source Clips
DaVinci Resolve also supports media with multiple audio tracks that have differently formatted 
channels embedded within them. For example, a clip with one stereo track, one 5.1 surround 
track, and six mono tracks can all be appropriately set up in the Audio panel of Clip Attributes 
after that clip has been imported.

The Audio panel of Clip Attributes now has controls over what format (Mono, Stereo, 5.1, 7.1, 
Adaptive) the channels embedded within a particular clip should be configured as. This means 
that you can set up clips with multiple tracks, each one using potentially different formats of 
audio employing different combinations of clips, which is handy for mastering.
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Clip Attributes now lets you assign channels among 
different tracks with different channel assignments

Timecode Attributes
If you find yourself dealing with clips that have incorrect timecode, or timecode with an 
incorrect relationship to the EDL, XML, or AAF project you’ve been given, you can use these 
attributes to modify the timecode and reel name of clips in the Media Pool. None of these tools 
alter the source media on disk. They simply change the timecode metadata in your 
DaVinci Resolve project, which by extension affects the timecode of any media you render.

The Timecode panel of the Clip Attributes window
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 � Current Frame Timecode: Lets you assign a new time for the timecode at the currently 
viewed frame of the clip.

 � Slate Timecode: In situations where source media comes from a shoot where a 
timecode slate was used during the shoot, then you can assign the slate timecode as 
a second timecode track that can be used for various operations, without changing the 
primary timecode of the clip, which may already be in use for program sync. 

To set appropriate Slate timecode, select a clip in the Media Pool with a visible 
timecode slate, and move the playhead to a frame where the timecode in the slate is 
clearly readable. Then, open the Timecode panel of the Clip Attributes window, and 
type the timecode value you see in the image into the Slate Timecode field.

 � Offset Source Timecode: If an entire set of clips has timecode that’s merely offset, you 
can correct the timecode offset for as many selected clips as you like.

Reel Name Attributes
The “Assist using Reel Names” checkbox in the General Options panel of the Project Settings is 
an extremely important setting for controlling how the conform process works. By default it’s 
turned off, and Reel Names are left blank. This is fine for conform workflows where all you need 
is the file path or file name and source timecode to successfully identify which media files 
correspond to what clips. However, if you need more information than that to reconform the 
clips in your project, you can turn on the “Assist using Reel Names” checkbox to enable 
DaVinci Resolve to use one of four different methods to automatically define reel names for 
every clip in the Media Pool.

Using the Clip Attributes dialog, you also have the option of manually defining how one or more 
selected clips in the Media Pool have their Reel Names defined. This is useful when there are 
certain clips in a project that need to use a different method of reel name extraction, or 
manually entered reel names. Once you’ve used Clip Attributes to change the reel names of 
clips, those clips no longer automatically update when you change the “Assist using Reel 
Names” options in the Project Settings.

You must first turn on “Assist using Reel Names” in the General Options of the Project Settings, 
and choose a Reel Assist setting, for the reel name attributes in the Clip Attributes window to 
be editable.

The Reel Name panel of the Clip Attributes Window
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 � Source clip file pathname: Obtains the reel name by extracting it from each media 
file’s path. This makes it possible to extract a reel name from all or part of the file name, 
or from all or part of the name of any folder in the path that encloses that file. This 
extraction is defined using the Pattern field.

 � Pattern: A code that defines how a reel name should be extracted from the source clip 
pathname. More information about creating patters appears later in this chapter.

 � Media Pool bin name: The reel name is obtained from the name of the bin in the 
Media Pool that encloses that clip. For example, in a stereoscopic workflow you might 
want to export offline stereo media with the “Left” and “Right” bin names in which 
they’re organized as reel names. Another example would be organizing VFX being 
incrementally processed in individually named bins, such as “VFX_Tuesday_10-12.”

 � Embedding in Source clip file: Useful for file formats where the reel name is 
embedded within the media file itself. CinemaDNG and other digital cinema cameras, 
QuickTime files created by Final Cut Pro, and DPX frame files are formats that can 
contain reel name header data.

 � Source clip filename: If there is no defined reel number, often it’s easy to just use the 
Source clip filename.

 � User Defined: This option is only available when you manually alter the reel name for 
one or more selected clips in the Media Pool using the Clip Attributes dialog. Choosing 
User Defined lets you type any string of text you like to use as the reel name.

Update Timecode from Audio — LTC
Some cameras do not offer the ability to sync to an external timecode source. Their recorded 
timecode may be time of day or free run timecode, but it would not be frame accurately synced 
to other cameras, the dual system audio recorder or the digital slate. This makes multi-cam or 
dual sound system syncing a time consuming manual operation.

DaVinci Resolve offers a solution to this problem if, by connecting an externally generated 
timecode to the camera audio input, the video that’s recorded by the camera has a timecode 
reference recorded on the audio track during the shoot. 

Select this clip, or clips, in the media pool, then right-click on one of the highlighted clips and 
select “Update timecode from audio - LTC.” DaVinci Resolve automatically and instantly updates 
the clip timecode using the LTC it finds on the audio tracks. You can now use the clips as 
though they were synced on set.

Changing Clip Thumbnails 
in the Media Pool
When the Media Pool is in Thumbnail mode, each clip is represented by a small image that 
defaults to the first frame of that clip. You can scrub the thumbnail of any clip to view its 
contents using the pointer after hovering over it for a moment. However, when you’re done 
scrubbing, moving the pointer away from any clip returns its thumbnail to the first frame of 
media, which may or may not be representative of its contents. 
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You can change this, if you like.

1 To customize the thumbnail of any clip:

2 Move the pointer over a clip you want to customize the thumbnail of.

3 Hover for a moment, then scrub to a representative frame.

4 Right-click that clip, and choose Set Poster Frame.

To clear the custom poster frame of any clip:
Right-click a clip and choose Clear Poster Frame.

Creating Subclips
Subclips give you another way of organizing media in the Media Pool, letting you break 
excessively long clips into shorter ones. For example, if the director of a project is fond of 
“rolling takes” where multiple takes are all recorded within a single clip, you can break these 
takes up by making them into subclips.

To create a subclip:
1 Select any clip in the Media Pool to open it into the Viewer.

2 Set In and Out points to define the section you want to turn into a subclip.

3 Do one of the following:

 – Right-click the jog bar and choose Make Subclip. 

 – Drag a clip from the Viewer or Source Viewer into the Media Pool.

A new subclip appears in the Media Pool, automatically selected so that you can 
immediately edit its metadata in the Metadata Editor.

Once created, subclips appear and work like any other clip in DaVinci Resolve.

Removing or Changing Subclip Limits
Once created, you can right-click any subclip in the Media Pool or a timeline and choose Edit 
Subclip to open a dialog in which you can turn on a checkbox to use the subclip’s full extents, or 
to change the start or end timecode of the subclip via timecode fields, before clicking Save to 
modify the subclip.

The Edit Subclip dialog
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Organizing Stereo 3D Media
When working with stereo media in DaVinci Resolve, one of the first tasks you must perform is 
that of syncing each stereo pair of clips to act as a single clip. This is easily accomplished so 
long as you’re careful about how you organize your media in the Media Pool.

Each set of right- and left-eye media should always be organized into separate left-eye bins and 
right-eye bins, to facilitate later syncing of these clips using the Stereo 3D Sync command in the 
Media Pool contextual menu. For more information about setting up media for stereo 
workflows, see the “Stereoscopic Workflows” section of Chapter 143, “Stereoscopic Workflows.”

Camera Raw Decoding
Camera raw media formats are so named because they capture raw color space data directly 
from the sensor of whatever digital cinema camera did the recording. Raw image data is not 
human readable, and must be debayered or demosaiced to convert the original raw data into 
image data that can be handed off to DaVinci Resolve’s image processing pipeline.

There are four ways you can control how camera raw media is debayered into a useful, 
“normalized” image for adjustment or output:

 � The Camera Raw panel of the Project Settings contain groups of parameters that 
correspond to every camera raw media format that’s supported by DaVinci Resolve. 
Using these parameters in the Camera Raw panel, you can override the original camera 
metadata that was written at the time of recording, and make simultaneous adjustments 
to all camera raw media throughout your project.

 � When you right-click one or more selected camera raw clips in the Media Pool, there 
are a series of “Edit Codec Settings” menu options corresponding to each supported 
camera format in the contextual menu that appears. Choosing one of these commands 
opens a Camera Raw window that exposes controls mirroring those found in the 
Camera Raw panel of the Project Settings.

 � The Camera Raw palette in the Color page lets you individually adjust Camera Raw 
parameters for individual clips in the Timeline.

 � When you use Resolve Color Management (RCM) in a project that uses Camera Raw 
formats, color science data from each camera manufacturer is used to debayer each 
camera raw file to specific color primaries with linear gamma, so that all image data 
from the source is preserved and made available to DaVinci Resolve’s color managed 
image processing pipeline. As a result, the Camera Raw project settings and Camera 
Raw palette of the Color page are disabled, because RCM is controlling the debayering 
of all camera raw clips, and all image data from the raw file is available for conversion to 
the Timeline Color Space you choose to work with as you grade.

For more information about each of the Camera Raw formats that can be adjusted in 
DaVinci Resolve, see Chapter 5, “Camera Raw Settings.”
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Chapter 15

Using 
Scene Detection

If you have a program that someone has delivered as a single media file, 
with no accompanying EDL with which to split it up, you can use 
DaVinci Resolve’s Scene Detect window to automatically find the cut 
points and split it into individual clips, ready for grading.
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Using Scene Detection
Initiating scene detection is easy:

To open a clip into the Scene Detect window:
1 Open the Media page, and use the Media Storage browser to find and select the clip 

you need to split apart. Do not add a clip you want to use scene detection on to the 
Media Pool first. You need to use Scene Detection before the clip has been imported.

2 Do one of the following:

 � Right-click the file and choose Scene Cut Detection.

 � Using the DaVinci control panel, press SHIFT DOWN and DECK/REVIVAL/SCENE 
on the T-bar panel.

The Scene Detect window opens up, containing the clip you selected.

The Scene Detect Window Interface
The Scene Detect window is divided into three main areas, the viewers, the Graph, and the 
Cut List. Together, these controls let you analyze the movie, examine the automatically found 
cuts, and manage the Cut List in preparation for sending back to your project.

Scene Detect window

The Scene Detect Viewers
A set of three viewers appear at the top of the Scene Detect window. These three viewers are 
designed to make it easy to test whether the playhead in the Scene Detect Graph is on a cut 
point or not. The leftmost viewer is the last outgoing frame of a detected cut point. The center 
viewer shows the first incoming frame of that cut point, and the rightmost viewer shows the 
second incoming frame of that cut point. 

Chapter – 15 Using Scene Detection 309



If the playhead in the Scene Detect Graph is directly on top of an edit point, the leftmost viewer 
should show a completely different frame than the center and rightmost viewers, which should 
be very similar to one another. This can be seen in the following example.

The Scene Detect viewers show the last frame of the 
outgoing clip, and the first two frames of the incoming clip

If all three viewers appear to display a continuous series of frames, then you’re not looking at a 
cut point.

No scene cut here as all images are almost the same

Underneath the viewers are a series of controls.

The Scene Detect viewer transport controls

 � Transport controls: A set of seven transport controls include first frame, step back, play 
reverse, stop, play forward, step forward, and last frame.

The In, Out, Prune, and Show Cut List controls

 � In: Lets you set a red In point, with which to define a range of the Scene 
Detection Graph to prune.

 � Out: Lets you set a cyan Out point, with which to define a range of the Scene 
Detection Graph to prune.

 � Prune: If you’ve identified a large number of false positive scene cuts (for example, 
a cluster of cuts corresponding to a dissolve from one shot to another), use the In and 
Out buttons to surround the undesirable range of scene cuts in the Scene Detect 
Graph, and then click Prune Scene Cuts to eliminate all scene cuts between these 
points that are within one frame of another scene cut. Within the group of identified 
cuts, the highest probability cut will remain while the other cuts are deleted.
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(Left) Isolating scene cuts to prune with In and Out points,  
(Right) The result of clicking the Prune button to eliminate all unwanted scene cuts but one

 � Show Cut List: Shows and hides the Cut List, which shows the currently detected 
scene cuts.

The Scene Detect Graph
The majority of the bottom half of the Scene Detect window, to the left, consists of the 
Scene Detect Graph, which shows the scene detect analysis results after you’ve clicked 
the Start button.

Detection graph displays potential scene cuts

Frames that DaVinci Resolve thinks are cut points appear as green vertical “scene cuts” 
of various heights. The height of each scene cut corresponds to the likelihood that frame is 
really an edit point, and not a swish pan, sudden jump in the motion of the frame, or abrupt 
change in color or lighting, all of which can fool the scene detection algorithm.

A horizontal magenta confidence bar lets you choose the threshold of confidence required for 
scene cuts to be added to the Cut List. If you drag this bar up above any shorter scene cuts of 
low confidence, those lines turn gray and are omitted from the Cut List. 

NOTE: Dissolves and other transitions are not automatically detected, although 
dissolves most often appear as a triangular cluster of lines peaking in the middle.
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Four controls appear underneath the graph.

 � Start Scene Detect: This initiates the scene cut detection process.

 � Add: Lets you manually add a scene cut at the current position of the playhead. 
Sometimes two adjacent clips with similar color and lighting will appear to be a single 
clip to the scene detection algorithm. This lets you add scene cuts at frames where 
they weren’t initially found.

 � Delete: Lets you manually delete a scene cut located at the position of the current 
frame indicator within the graph. 

 � Zoom slider: Lets you zoom into and out of the Scene Detect Graph to see more or less 
detail as you examine the results. 

Cut List
At the lower right of the Scene Detect window, the Cut List displays one entry for each of the 
scene cuts that intersect the confidence bar. 

The Cut List shows all currently detected cuts

Three columns show each cut’s order number, frame number, and timecode value. You can 
select items in the Cut List to evaluate each cut using the three viewers above. Whenever you 
select a new item in the Cut List, the playhead jumps to that frame in the Scene Detect Graph. 
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To select items in the Cut List:
 � Click any item in the Cut List.

 � Press N (next) or the Down Arrow to select the next item down.

 � Press P (previous) or the Up Arrow to select the next item previous.

As you move up and down the list, you can delete items that you can confirm aren’t real cuts 
using the viewers above. If it’s a long list and you don’t have time to check it all at once, it can 
be saved for later recall using commands found in the Scene Detect Options pop-up menu.

Once you’re finished checking the list and are satisfied that each cut is accurate, you can use it 
to split the media file into individual clips in the Media Pool by clicking “Add Cuts to Media Pool,” 
located immediately below.

The Scene Detect Options Pop-Up Menu
The Options pop-up menu, located at the upper right-hand corner of the Scene Detect window, 
contains a variety of commands.

Reset Zoom: Sets the zoom level of the Scene Cut Graph such that the entire clip fits within the 
current width.

 � Reset Marks: Clears the current In and Out points you’ve set.

 � Prune Scene Cuts: If you’ve identified a large number of false positive scene cuts (for 
example, a cluster of cuts corresponding to a dissolve from one shot to another), use 
the In and Out buttons to surround the undesirable range of scene cuts in the Scene 
Detect Graph, and then click Prune Scene Cuts to eliminate all scene cuts between 
these points that are within one frame of another scene cut. Within the group of 
identified cuts, the highest probability cut will remain while the other cuts are deleted.

 � Save Scene Cut: Saves the current scene cut detection information, including the 
probability metadata, to disk. Scene Cut files use the file extension .sc and can be 
reimported later to continue working on a lengthy scene detection task.

 � Load Scene Cut: Imports an existing .sc file into the Scene Detect window. You must 
first open the media file you’re working on into the Scene Detect window before you 
can load a Scene Cut file.

 � Save EDL: Exports the Cut List as a CMX-style EDL.

 � Load EDL: Loads a CMX-style EDL into the Cut List, letting you use the cut information 
from the EDL during the Scene Cut Detection process.

 � Auto Cue: When enabled, the playhead jumps to each new scene cut as it’s detected 
when you initiate scene detection. This lets you evaluate each scene cut as it’s found 
using the three viewers above.
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An Example Scene Detect Workflow
This section describes an ideal workflow for using scene detection without an EDL.

To scene detect a media file:
1 Locate a media file to scene detect using the Media Storage browser of the 

Media page. 

2 Verify its frame rate and if it uses drop-frame timecode, and make sure that the 
“Timeline frame rate” matches the “Use drop frame timecode” parameter in the 
Master Settings panel of the Project Settings. These parameters are not automatically 
set if the project already has media in the Media Pool, and you may have problems if 
they don’t match your media.

3 Right-click the media file, and choose Scene Cut Detection.

4 When the Scene Detect window appears, click the Options pop-up menu and choose 
Auto Cue (it should be on by default, but it’s always good to check), then click Auto 
Scene Detect.

Scene detection initiates, and you can evaluate each scene cut as it’s found. If any 
scene cut looks wrong (three sequential frames in a row), note its place in the list for 
future evaluation.

5 When DaVinci Resolve has finished scene detection, move the playhead to some of 
the shorter scene cuts, and verify if they’re actual cuts by checking the three viewers 
above. If the frames being displayed are “different-same-same,” then it’s a genuine cut. 

If the frames being displayed are “same-same-same” (actually three sequential frames), 
then these aren’t cuts.

TIP: Fast camera motion such as whip pans, sudden changes in lightness such 
as camera flashes, or even film coming up to speed causing the shutter to 
“flash” can confuse the analysis, which looks for large changes in the image.

6 If there are numerous low-confidence scene cuts that you’ve verified aren’t cuts, drag 
the magenta confidence bar so that the low-confidence scene cuts fall below it to 
automatically remove them all from the list.

7 Next, you may want to move down the Cut List, evaluating each scene cut to verify that 
it’s correct. Click the first scene cut in the list, check it, then press the keyboard Down 
Arrow key to select the next list item down, check it, and repeat until you’ve checked 
every item in the list. If you need to move back up the list, you can press the Up Arrow 
key to select the previous list item. If any item is not a cut point, click the “Minus” button 
at the bottom left corner of the Scene Detect window to eliminate that scene cut.

8 If there are sections in the Scene Detect Graph with dense groups of spikes, these are 
probably frames with types of motion that confused the Scene Cut Detector. To delete 
this unwanted “noise” in the data, use the In and Out buttons to isolate the data, and 
then click “Prune” to delete these unwanted scene cuts.
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9 If there’s a gap between any two scene cuts that you’re positive should have another 
scene cut, then scrub the playhead or use the transport controls to find the missing cut, 
and click the “Plus” button at the bottom left corner of the Scene Detect window to add 
another scene cut.

TIP: Adjacent shots with very similar ranges of color and contrast may 
sometimes go undetected by the scene detection algorithm. If you know 
of scenes in the media you’re analyzing that are like this, you may want to 
scrub through them a bit more carefully to make sure you’re not missing 
anything. However, if you find you’ve missed a cut later, you can always use 
the Split Clip control in the Edit page timeline to add a new edit point.

10 When you’re confident that the Cut List is accurate, split the media file into individual 
clips in the Media Pool by clicking “Add Cuts to Media Pool.”

11 When the Conform Settings dialog appears, click OK if you checked your settings 
in step 2.

12 Close the Scene Detect window.

The individually cut up clips of the media file you analyzed now appear in the 
Media Pool, and you can edit the entire sequence of clips into a new Timeline in order, 
ready for grading.
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Chapter 16

Ingesting 
From Tape

DaVinci Resolve is capable of capturing media from tape using a 
compatible video input device, such as a Blackmagic Design UltraStudio 
or DeckLink card. Device control is supported.
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Tape Ingest
This chapter covers how to capture media from tape directly into the Media Pool in 
DaVinci Resolve. Whether you need to capture a handful of clips to incorporate into an existing 
project, or you need to recapture every clip corresponding to the events of an EDL, you can use 
the Media page in Capture mode to capture from any device-controllable deck via a compatible 
video interface.

To switch to tape capture in the Media page:
Click the Capture button, located to the left of the Interface toolbar at the top of the 
Media page.

The Media page updates to reflect the relevant controls for editing to tape, and the Audio panel 
is replaced by a dedicated set of capture metadata and controls to help you track the 
resulting clips.

The Tape Capture Interface
While in Capture mode, the Media page is used to control the VTR, in order to establish In and 
Out points for logging or capturing a selected range of the tape.

Tape Capture viewer in the Media page

 � Transport controls: The transport controls, while similar in appearance to those 
used when simply playing through selected clips in the Media page, now work to 
control the VTR.

 � Shuttle control: A shuttle control appears in what was formerly the scrubber bar, which 
lets you shuttle through the range of reverse and forward speeds compatible with the 
connected deck.

 � In and Out controls: In Capture mode, the In and Out buttons to the right of the 
transport controls define a range of the tape from which to capture.
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 � Capture panel: The panel automatically switches to the Capture panel, with tape-
specific metadata and capture controls. Populating File Name Prefix updates the file 
name preview that’s shown above in the Header, that also shows the Capture directory, 
Resolution, and Frame Rate specified in the Capture and Playback panel of the Project 
Settings. 

Editable capture metadata 

Setting Up to Capture From Tape
Before you begin capturing from tape, you need to adjust a variety of settings in the Capture 
and Playback panel of the Project Settings. Two groups of settings, in particular, need to 
be defined.

Deck Settings
These settings affect both capture and playback when using the Tape Ingest options of the 
Media page, or the Tape Output options of the Deliver page.

Video capture and playback: You can choose the video format (frame size and frame rate) with 
which to output to tape from this pop-up menu. HD timelines can be downconverted to SD, and 
SD timelines can be upconverted to HD using the format conversion of your DeckLink card.
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Use left and right eye SDI: A checkbox that enables the Blackmagic Design DeckLink HD 
Extreme 3D+ to ingest and output muxed stereoscopic video when used with supported VTRs, 
such as HDCAM SR decks with 4:2:2 x 2 mode. (When muxed stereoscopic signals are 
ingested, each eye is separated into individual left-eye and right-eye image files.)

 � Video connection operates as: Selects between the available signal options: Use 
4:4:4 SDI and Enable Single Link. Which options are available depend on which video 
capture card you are using.

 � Data Levels: Lets you specify the data range (normally scaled or full range) that’s used 
when ingesting from or outputting to tape. This option switches the data range of the 
signal output by your video capture card, but only during capture from tape in the Media 
page, or output to tape in the Deliver page. When capture or output is not currently 
occurring, your video capture card goes back to using the identically named data range 
setting in the Master Settings panel of the Project Settings pane, which governs how you 
monitor the signal being output on an external broadcast display or projector.

 � Video bit depth: 10-bit is the only available option.

 � Use deck autoedit: If supported by your video deck, this is the best method to record 
video to the deck, as it enables the deck to roll the edit using the specified preroll, and 
control the edits via serial device control. If this checkbox is turned off, a basic edit On/
Off mode is used by the deck, with the potential for frame inaccuracies if the “Non auto 
edit timing” setting is not properly adjusted.

 � Non auto edit timing: Adjusts the edit synchronization of the connected deck when 
auto edit is turned off.

 � Deck preroll: Sets the number of seconds for preroll. How much is appropriate 
depends on the performance of your deck.

 � Video output sync source: When using a DeckLink card this is set to Auto. Other 
capture cards may require you to set the sync source to “Reference” for playout and 
“Input” for ingest. This setting is only available if you have the DVS card installed on 
your system.

 � Add 3:2 pulldown: Inserts or removes the 3:2 pulldown required to record or play 
23.98 fps media to or from a 29.97 tape format.

Capture
These settings are used when you use the Capture mode in the Media page to capture clips 
from tape into the Media Pool, or when controlling the Cintel Film Scanner to scan film of 
different formats.

 � Capture: Lets you choose whether to capture both Video and Audio, or Video only.

 � Video Format: The format captured media will be saved to. When capturing from tape, 
the available options are DPX and QuickTime.

 � Codec: The codec used to write captured media. When capturing from tape, these 
include the various type of Apple ProRes, 8- and 10-bit YUV 422, 10-bit RGB, and the 
various types of DNxHD.

 � Save clips to: A field that displays the directory path to which media files captured from 
tape are written. You want to choose a volume that’s fast enough to accommodate the 
data rate of the media format you’re capturing.

 – Browse: Click this button to choose a directory to write captured media to. 
The directory you choose appears in the field above.
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 � Save in this folder path: A series of checkboxes lets you specify what other information 
to use to define the directory hierarchy that will hold the captured media. Every 
checkbox you turn on adds an additional directory with a name defined by that 
checkbox’s metadata. You can choose any or all of the following: Program name, Clip 
number, Reel number, Roll/Card.

 � Apply reel number to: Lets you choose how to write the reel name. Two checkboxes 
let you write the reel name to the file’s name, and/or to the Header data.

 � Use prefix: A field lets you type in a prefix to be used in the media file’s name. This 
lets you add text identification that will make the media more easily identifiable and 
searchable.

 � Apply prefix to: Two checkboxes let you choose to use the prefix you typed in the file 
name, and/or in the folder name.

 � Use frame number with: When capturing to image sequences, you can choose how 
many digits to use when writing the frame number into the name of each frame file.

 � Set batch ingest handles to: Lets you add additional frames of handles to the 
beginning and end of each scanned clip when batch capturing with the scanner.

 � Input: A pop-up that lets you choose how many tracks of audio to capture, from 2 to 16.

The Three Methods of Capture
Once you’ve set up all relevant settings in the Project Settings window, including at minimum 
“Video Capture and Playback,” “Capture Clips Saved to,” and Apply Reel Name to” settings, 
then you’re ready to start capturing. Depending on your workflow, there are three methods of 
capturing from tape that you can use.

For all capture methods, media can only be ingested as DPX image sequences.

Using Capture Now
If you simply need to capture a section of tape quickly, you can use the Capture Now command.

To Capture Now:
1 Use the transport controls and the In button to identify what you want to capture.

2 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3 Use the transport controls to start playback, and then click the Capture Now button at 
the bottom of the Metadata Editor.

4 When the section of tape you wanted to record has finished, click Capture Now again 
to stop capture.

A new clip appears in the Media Pool, automatically placed in a new folder in the Media 
Pool with a name defined by the timecode value converted into a frame count, based 
on the ingest frame rate. For example, 00086400.dpx is the file name of a clip 
captured at timecode 01:00:00:00.
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Logging and Capturing Individual Clips
If you’re capturing an exact range of tape, or multiple sections at once, you can also work by 
logging each section of tape you want to capture in advance, before using the Capture Clip or 
Batch Clips commands in a second step.

To capture a single clip using device control:
1 Use the transport controls to find the beginning of the section of tape you want to 

record, and click the In button. Then, find the end of the section of tape you want to 
record, and press the Out button.

2 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

3 When you’re finished, click Capture Clip.

Deck control is automatically used to play through the specified range of tape and 
capture that clip. When capture is complete, the new clip appears in the Media Pool.

Logging and Capturing Multiple Clips
For efficiency’s sake, you can also log multiple clips at once, from multiple tapes if necessary, 
and then batch capture them all at once.

To log one or more clips:
Use the transport controls to find the beginning of the section of tape you want to record, and 
click the In button. Then, find the end of the section of tape you want to record, and press the 
Out button.

1 Enter all relevant information into the various fields of the Metadata Editor. The Header 
updates to show a preview of the file name that will be saved.

2 When you’re finished, click Log Clip.

3 That clip is added to the Media Pool as an offline tape clip, indicated by a black icon 
with a tape badge.

Logged clip in the Media Pool prior to capture

To batch capture one or more logged clips:
1 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort 

the Media Pool clips by reel number. This makes it easier to select a range of clips to 
capture from a particular reel. 

2 Select one or more offline tape clips in the Media Pool that come from a particular reel.

3 Click Batch Clips, at the bottom of the Metadata Editor. To interrupt capture at any time, 
click Batch Clips again.

Deck control is automatically used to play through the current tape in the VTR and 
capture every logged clip you’ve selected that can be found on that tape, starting with 
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the clip with the lowest timecode value and ending with the clip having the highest 
timecode value. A progress bar with accompanying text shows how much longer to go 
until capture is complete. As each clip is captured, its corresponding logged clip in the 
Media Pool updates with a thumbnail reflecting the captured media. 

When DaVinci Resolve finishes capturing all clips from a particular reel, Batch 
Capture stops. 

Batch Capture Via EDL
You can also use an EDL to create offline tape clips, one for each event in the EDL, with which 
to batch capture all the media necessary to conform a project from tape.

To import an EDL as a batch capture list:
1 Open the Project Settings, click Master Panel in the sidebar, and make sure of 

the following:

 – Set “Timeline frame rate” to the frame rate of your EDL.

 – Turn on “Use drop frame timecode” if your EDL requires it.

 – Make sure “Use Timecode” is set to “Embedded in the source clip.”

 – Turn on “Assist using reel names from the.”

2 Choose File > Import Batch List From EDL.

3 When a Conform Settings dialog appears asking you to confirm the current Project 
Settings, click OK if the settings are good.

4 Use the controls of the Select EDL files dialog to select one or more EDLs, then click 
Open. If you select multiple EDLs, then every event in each EDL is imported at once.

5 In the dialog that appears next, choose a frame rate to conform the EDL at, and click OK.

Each event in the EDL now appears as offline tape clips in the Media Pool, ready for 
capturing. If you load an EDL and there are already clips in the Media Pool that have the 
same reel name and start timecode as events in the EDL, DaVinci Resolve will not 
create new offline tape clips for those.

A set of logged clips imported from an EDL

6 (Optional) Put the Media Pool into List view, and click the Reel No column header to sort 
the Media Pool clips by reel number. This makes it easier to select a range of clips to 
capture from a particular reel.
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7 (Optional) If there are any offline clips that you don’t need to capture, you can remove 
them from the Media Pool by right-clicking them and choosing Remove Selected Clips.

8 Select which of the offline tape clips you want to capture. It’s best to select ranges of 
clips that come from the same reel.

9 Click the Capture mode button to the left of the transport controls, and then click Batch 
Clips to begin capture. To interrupt capture at any time, click Batch Clips again. Deck 
control is automatically used to play through the current tape in the VTR and capture 
every logged clip you’ve selected that can be found on that tape, starting with the clip 
with the lowest timecode value and ending with the clip having the highest timecode 
value. A progress bar with accompanying text shows how much longer to go until 
capture is complete. As each clip is captured, its corresponding logged clip in the 
Media Pool updates with a thumbnail reflecting the captured media. 

When DaVinci Resolve finishes capturing all clips from a particular reel, Batch Capture stops.
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Chapter 17

Capturing 
from the Cintel 
Film Scanner

This chapter details how to ingest scanned film using DaVinci Resolve 
settings and workflows to control the Cintel film scanner.
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Controlling the Cintel Film Scanner
The Blackmagic Cintel film scanner is a compact, easy to use, real time film scanner capable of 
converting 35mm and 16mm (with a separately purchased gate) positive and negative film 
formats into Cintel Raw Image (CRI) digital files that can be organized, edited, and graded using 
DaVinci Resolve, delivered to any format DaVinci Resolve can output, and archived for later use.

The Cintel scanner

DaVinci Resolve can control any Blackmagic Cintel film scanner that’s connected to your 
computer via Thunderbolt 1 or 2. Once connected, the Film Scanner controls in the Media page 
can be enabled, which let you choose the film type to be scanned, align the film frames to the 
sensor, adjust the scanner’s light source for optimal exposure and color, and choose whether to 
use the scanner’s hardware-based Automatic Perf Detection to perform image stabilization.

NOTE: This chapter of the DaVinci Resolve manual describes the use of a Cintel film 
scanner connected to DaVinci Resolve for the purpose of ingesting scanned film. For 
other operational inquiries, please see the documentation that accompanies the 
scanner itself, or visit the Blackmagic Design support page on the web to download it.

Similar to Tape Capture, you can choose to scan sections of film a shot at a time, or as part of a 
batch capture workflow by logging all of the clips on a particular roll that you want to scan.

The Cintel Raw Format

The raw Bayer pattern of each film frame scanned with the Cintel scanner sensor is 
saved with embedded scanner metadata as a 12-bit linear Cintel Raw Image (CRI) 
image sequence. When grading in DaVinci Resolve, CRI raw images are automatically 
debayered as 12-bit log-encoded image data. The logarithmic encoding is similar, but 
not identical, to Cineon encoding; negative film is encoded using a gamma of 2.046 for 
density, while print film is encoded using a full-range Gamma 2.2 curve to ensure that 
no image data is clipped. Both of these logarithmic encodings can be converted to a 
linear color space using the “Cintel to Linear” 1D LUT, as a precursor to converting to 
other color spaces you may want to work in.
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The film is scanned using the full sensor aperture of 4096x3072 for an extracted 
35mm or 16mm image to accommodate waveform visibility for audio extraction and 
perforation visibility for stabilization, but 16mm is cropped to 2160x1702. The resolution 
of the resulting files depends on the source film format; Super 35 film is at the UHD 
resolution of 3840x2877, while Super 16 format scans are at nearly HD resolution at 
1903x1143. The resultant files are approximately 22.4MB for a 35mm frame and 
6.6MB for 16mm.

Cintel Raw Image files don’t have dedicated debayering controls in DaVinci Resolve. 
To control the quality of debayered CRI files, use the Decode Quality and Play Quality 
CinemaDNG settings of the Camera Raw panel of the Project Settings.

The Cintel Scanner Interface
If you have a Cintel Scanner connected to your computer, then clicking the Capture button in 
the UI toolbar at the top of the DaVinci Resolve screen sets the Media page to control either the 
Cintel scanner or a video deck that’s been connected to your workstation. For film scanning, 
open the Film Scanner panel to set up, calibrate, and choose options for logging or scanning a 
selected range of the currently spooled roll of film. If you want more room for viewing the Cintel 
scanner controls, click the full height button that’s all the way to the right of the UI toolbar, and 
turn off the Metadata panel.

Cintel scanner controls in the Media page

 � Transport controls: These controls, while similar in appearance to those used while in 
Playback mode, now work to control the Cintel scanner. Additional controls appear for 
moving forward or backward a frame at a time.

 � In and Out controls: In Cintel Scanner mode, the In and Out buttons to the right of the 
Transport controls define a range of the film roll from which to capture.

 � Capture Info: In Cintel Scanner mode, a set of capture metadata fields appears at 
the bottom of the Film Scanner panel. Populating the File Name Prefix updates the 
file name preview that’s shown above in the Header, that also shows the file path, 
Resolution, Frame Rate, Duration, and Format (Cintel Raw Image). 
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Editable capture metadata 

Before you begin scanning, you may want to adjust the settings in the Cintel Scanner panel of 
the Project Settings, and you’ll definitely need to adjust some settings in the Cintel panel of the 
Media page.

Capture Location in the Capture Info Section

Prior to beginning a film scanning session, you should scroll down to the Capture Info 
section of the Capture panel to make sure the scanned files are being saved to the 
directory and volume where you want them. Click the Browse button and choose a 
location from the File Destination dialog. It’s good to do this first, as this step is easy 
to forget.

Your clips will be saved to independent subfolders in the destination folder, with a 
timecode prefix in the file name. If you want to save all your clips into one master 
destination folder, deselect the Timestamp Prefix checkbox in the Capture Info section.

Cintel Media Page Settings
The following groups of settings appear to the right of the Media page Viewer when in Cintel 
Scanner mode to scan clips from film into the Media Pool.

Calibration
This option lets you calibrate the optics of the scanner to eliminate optical blemishes or dust 
that cannot be removed (this is not for dust-busting the film itself ).
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The calibration button underneath Image Stabilization

 � Calibrate button: Lets you eliminate light optical blemishes and dust from the optics 
of the Cintel scanner via digital calibration. While it’s recommended to spray dust the 
optics before scanning new material, it’s possible over time for some blemishes on the 
optics to be unremovable, in which case using the Calibrate button will eliminate them 
from the scanned image. The skid plate does not normally need to be removed for 
calibration; however, in cases where there is severe dirt, remove the skid plate and dust 
it first. You must use the Calibrate button before you load film into the scanner, while 
there’s nothing in the optical path, to remove any remaining optical blemishes or dust.

Film Type
These controls let you select the type of film you’re scanning, align the film with the sensor, and 
choose what speed you’re scanning at.

Film Type controls in the Media page

 � Film Type pop-up: Lets you choose what type of film you’re scanning. The choices are 
Positive, Negative, Interpositive, and Internegative. 

NOTE: When scanning interpositive film, the increased density of the film 
requires slightly extended pulse durations from the light source. Normally, this 
does not affect the scan, however, a slight reduction in resolution may occur 
when scanning at above 12 frames per second. If you do notice a difference in 
resolution, simply reduce your scanning speed to 12 frames per 
second or less.

 � Gauge and perf count pop-up: Lets you choose what reel type you’re scanning; the 
choices are 35mm 2, 3, and 4 perf, and 16mm 1 perf.

 � Perf nudge buttons: Used for making fine adjustments of the perf position relative to 
the scanner gate aperture. Command-J  nudges up, while Command-L nudges down.

 � Frame buttons: These buttons are push and hold to activate; when on, the film is slowly 
advanced to move the frame up or down and when released the film stops in place. 
This is useful for aligning the film frame with the scanner’s sensor. Using the Perf Nudge 
and Frame buttons, align the visible film frame such that the bottom of the previous 
frame and the top of the next frame are just visible at the top and bottom of the Viewer, 
and the current frame is centered vertically (it’s important to make sure the image in the 
Viewer is not zoomed in when you do this). Command-Left Arrow moves the frame up, 
while Command-Right Arrow moves the frame down.

Chapter – 17 Capturing from the Cintel Film Scanner 330



 � Scan speed slider: With adequate disk performance, you should be able to scan at 
30 fps. However, if you’re scanning to a slow hard drive, you can reduce the scanning 
speed to a frame rate that’s suitable for your workstation without dropping frames.

 � Feed buttons: Sets the wind direction of the left-hand side feed spool. While auto-
detection will prevent incorrect operation, you should manually configure the reel 
winding direction based on how each film roll is wound.

 � Take up buttons: Sets the wind direction of the right-hand side take up spool. While 
auto-detection will prevent incorrect operation, you should manually configure the reel 
winding direction based on how each film roll is wound.

 � Focus Assist checkbox: Enables luminance peaking on the scanner HDMI monitor 
output, which makes it easy to obtain optimum focus adjustments.

Light Source
These controls let you adjust the scanner’s light source to adjust the optimal Dmin (the minimum 
scanned signal value) and color temperature of the scanned material. Using the built-in software 
scopes in DaVinci Resolve, which can be opened in the Media page by choosing Workspace > 
Video Scopes > On, you can adjust these settings to make sure you’re not clipping image data 
during the scanning process.

Light Source controls in the Media page

 � Master Offset control: Adjusts the intensity of the light source used to illuminate the 
film, raising or lowering the RGB channels all at once. For typical camera negative, this 
lets you adjust the black point of the film image (the darkest part of the image, which in 
fact corresponds to the highlights of the film image) to sit just above the typical Dmin 
value of 95, as measured on the Histogram of the video scopes, which guarantees that 
the highlights won’t be clipped by a Cineon-style LOG conversion. For positive film, 
simply adjust Master offset so that no part of the signal is being clipped.

 � Auto Black button: Analyzes the current frame displayed in the Viewer and does an 
automatic adjustment to put the film base of the signal at the Dmin value of 95 for 
negative, or for print to set the white point to 90%.

 � RGB controls: By default, a color balance control lets you adjust all three color 
channels by varying amounts to alter the color temperature of the light source used to 
illuminate the film, while the adjusted R, G, and B values are displayed in three fields 
below. Optionally, you can choose to put this control into Color Bars mode using the 
mode pop-up to the right of the Light Source title bar, which changes this control to 
three vertical Red, Green, and Blue color channel sliders.
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Image Stabilization
These controls let you enable and disable as well as control image stabilization to eliminate 
vertical film hop and horizontal gate weave.

Image Stabilization controls in the Media page

 � Image Stabilization enable/disable control: The dot to the left of the Image 
Stabilization title bar lets you enable or disable the scanner’s hardware-based image 
stabilization altogether. While hardware stabilization is typically desirable when you 
have high-quality perforations, you may want to turn this option off if the condition 
of the perforations is poor and you decide to use DaVinci Resolve’s software-based 
stabilization instead. When Image Stabilization is enabled (the default), small white 
vertical (Y axis) and horizontal (X axis) detection overlays are displayed in the Viewer, 
highlighting which part of the film perforation is to be used as the reference for 
stabilization. These overlays are automatically hidden when recording.

 � Enable X and Y checkboxes: Lets you choose whether to use hardware image 
stabilization to fix horizontal gate weave (Enable X) and vertical gate hop (Enable Y). If 
the results are unsatisfactory with both axes enabled, you can turn off the axis that’s 
causing issues with stabilization.

 � Automatic Perf Detection checkbox: When enabled (the default), the Cintel scanner 
attempts to automatically place the stabilization detection overlay at the best location, 
with reference to the perforation shown on the currently loaded frame, for the best 
stabilization result. For optimum stabilization, the position of the overlay should 
resemble the following screenshot, with the box over the flat bottom area of the perf 
and the bar positioned in the middle of the perf. If the automatic positioning is not 
ideal, you can turn Automatic Perf Detection off, and manually move the overlay to a 
more ideal position, either by dragging it in the Viewer, or by using the Horizontal and 
Vertical sliders described below.

Hardware stabilization control correctly 
positioned over a perforation in the Viewer
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 � X and Y sliders: Used to manually reposition the stabilization overlay when Automatic 
Perf Detection is turned off. Ideal placement of the stabilization overlay should position 
the top box to surround the top flat edge of the perf, with the lower part of the overlay 
flush against and centered on the side of the perf. This enables hardware stabilization of 
vertical gate hop (along the Y axis), as well as gate weave (along the X axis). If the default 
position of the stabilization overlay is not ideal, you can either drag it to another location 
in the Viewer, or use the Horizontal and Vertical sliders to position it numerically.

Film Protection
These controls are intended to allow delicate film to be handled gently by the Cintel Scanner. 
Fast acceleration and shuttle speeds can be hard on archival footage, so it’s recommended to 
lower both of these sliders from their defaults whenever you’re scanning older film.

The Acceleration and Shuttle Speed sliders should be lowered 
when scanning older, delicate archival film

 � Max Acceleration: Changes the scanning speed to operate between 5–30 frames 
per second.

 � Max Shuttle Speed: Changes the speed of shuttling from one section of film to another 
between 1–100 frames per second for 35mm film, and between 1–200 frames per 
second for 16mm film.

 � Film Tension Adjust: Adjusts the amount of tension applied to the film. For example, 
when loading delicate archival film, or compensating for film shrinkage. 

NOTE: There is no possible way you can damage the film using the Film 
Tension Adjust setting. The adjustment values are very small and only gentle 
changes are all that’s required to prevent sprocket picking.

Film Scanning Workflows
The following sections describe how to scan film using DaVinci Resolve to control the Cintel 
scanner. Throughout, the procedures outlined above are presented in the order in which you’ll 
perform each step of the scanning process.

Before You Begin
Following the instructions that accompany your Cintel scanner, connect the Scanner to your 
workstation using a Thunderbolt cable. The Cintel scanner is compatible with either 
Thunderbolt 1 or 2, and either has the bandwidth to transfer the scanner’s output to 
your computer.

Before turning your scanner on and loading film, you should first dust the gate to make sure 
your scans are as clean as possible. This can be accomplished using compressed air, but if the 
gate is extremely dirty, you can remove it to give it a more thorough cleaning. Once that’s 
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finished, turn on the Cintel scanner, open DaVinci Resolve and create the project you’ll be using 
to scan film, then click the Cintel Scan button on the Media page. Next, click the Film Scanner 
tab to select the Cintel panel.

Before you load film into the scanner or do anything else, click the Calibrate button at the 
bottom left of the Cintel panel. While you should always dust the gate of the scanner before 
loading a new reel of film, clicking the Calibrate button eliminates any unremovable blemishes 
in the scanner’s optics from the scans you’re about to make.

Load and Align the Film
Load the film you want to scan. In the presence of an image, the scanner will automatically align 
a frame. You should note that the image may be framed incorrectly if you first load blank 
film leader.

Next, choose the Film type. If necessary, use the Perf Nudge and Frame buttons to manually 
improve the alignment of the framing bar to the scanner’s sensor such that the bottom of the 
previous frame and the top of the next frame are just visible at the top and bottom of the 
Viewer, and the current frame is centered vertically. It’s important to make sure the image in the 
Viewer is not zoomed in when you do this.

Focus the Scanner
Just as you need to focus the lens on a camera, you’ll need to focus the projected film image 
on your scanner’s sensor. To achieve perfect focus, turn on the Focus Assist checkbox in the 
Film Scanner capture settings of DaVinci Resolve. This superimposes a focus peaking overlay 
over the Ultra HD image that’s output from the scanner’s HDMI output, and is also displayed in 
DaVinci Resolve’s Capture window. For best results, connect an Ultra HD display to your Cintel 
scanner, so that you can monitor at the maximum available resolution while you focus.

With Focus Assist turned on, focus peaking will detect the film grain of the scanned image 
whenever the film plane is in perfect focus. This enables the operator to focus the scanner even 
if the film image is out of focus. Simply monitor the Ultra HD output of the scanner while you 
turn the Cintel scanner’s focus wheel. Your image will be in focus when the grain running 
throughout the image displays peaking outlines.

TIP: You can verify the focal adjustments you’ve made by checking the edges of your 
film’s perforations. When these are sharp, your film will be in focus.

Other Ways to Focus the Scanner

Another accurate way to achieve perfect focus, if you don’t have a display connected 
directly to the scanner, is to use DaVinci Resolve’s RGB Parade Scope to monitor the 
signal while you focus. Open the video scopes by choosing Workspace > Video 
Scopes > On. To see the Parade Scope in more detail, you can set the Video Scopes 
window to display only a single scope using the layout buttons at the upper right-hand 
corner of the Video Scopes window, and then choose the Parade Scope from the 
pop-up in the scope title bar (if necessary). 

To focus, watch the tops of the red, green, and blue scope graphs while you turn the 
Cintel scanner’s focus wheel. Your image will be in perfect focus when all three color 
channels in the scopes are “peaking,” or displaying the maximum amount of 
information at their highest point.
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Check the Automatic Perf Detection Stabilization Overlay
Next, play the loaded film and check that the automatic perf detection has found an appropriate 
section of the perf to successfully stabilize the film. If necessary, you can drag the stabilization 
overlay that appears in the Viewer so that the top box surrounds the top flat edge of the visible 
perf to make best use of the hardware-based stabilization built into the scanner.

Reset the Timecode for That Roll
To set the timecode for the roll of film you’re about to scan, you need to locate the zero frame 
for that roll. It’s standard practice to punch a small physical hole within the frame before the first 
frame of necessary film on a roll, to use as a permanent reference for whenever that roll is 
scanned. This is referred to as the marker frame, lab roll hole, or head punch. By always setting 
the first frame of timecode to match the marker frame, subsequent film scans will have the same 
frame count as previous scans, making it possible to rescan and reconform the same material 
whenever necessary. 

To reset scanned timecode at the marker frame of a new film roll:
1 Use the transport controls to locate the marker frame.

2 Click the Viewer option menu and choose Current Frame Timecode. 

Choosing Current Frame Timecode from the Viewer option menu

3 Enter a timecode value in the dialog box that appears. For example, if you’re scanning 
the first roll of a project, you can enter 01:00:00:00.

The Set Current Frame Timecode dialog

4 When you’re done, click OK. 

Timecode cannot be negative, so don’t set the start frame to zero. Another common 
organizational technique is to change the hour number whenever you change rolls, to coincide 
with the film roll’s number, which makes it easy to track the correspondence between a 
scanned clip and the source roll and frame range it was scanned from.

NOTE: The Cintel scanner does not read Keykode, Aaton code, or edge code from 
camera negative. However, the Cintel Scanner does have “Options Interfaces” ports 
for adding optional third-party hardware in the future to accomplish this.
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Choose a Location to Save the Scanned Frames
Once all this is done, scroll down to the Capture Info controls in the Capture panel, and click the 
Browse button to choose a location for the scanned files. You can use the other fields in this 
section to set what prefix (if any) you want to add to the name of the scanned files and 
enclosing folders, and what Roll, Reel, Clip, and Program information you want associated with 
the scanned media.

The Timestamp Prefix checkbox in the Capture info controls is selected by default and will save 
your clips to independent subfolders within the destination folder, together with a timecode 
prefix in the file name. If you want to save all your clips together in one master destination 
folder, simply deselect the checkbox.

Check the Frame Rate
There’s an FPS field in the Capture Info that identifies the frame rate of the scanned clips. Make 
sure this frame rate is set correctly to ensure that the header data of your film scans is correct.

Adjusting the Color of the Scanner
The Cintel panel gives you control over the exposure and color temperature of the light used to 
illuminate the film for scanning via the Master Offset and RGB Offset controls, in order to 
maximize the amount of information you’re extracting from each frame, while preventing any 
part of the image from being irretrievably clipped. While it’s true that CRI is a raw image format, 
there’s no latitude beyond the internal data range used by DaVinci Resolve; be mindful that if 
you’re clipping data in the built-in video scopes while scanning, it might be clipped permanently 
in the scanned media.

How often you’ll adjust the color and exposure of scanned shots depends on how much variety 
there is in the scenes on a particular film roll. For example, some rolls may have many takes of 
the same scene, all of which have the same lighting and which can share the same adjustments. 
Meanwhile, other rolls may have a variety of different scenes with widely different lighting in 
each one, necessitating you to make individual adjustments for each scanned clip to maximize 
data quality.

This is important because the Master Offset and RGB Offset settings cannot be automatically 
changed between scanned clips in a log and capture workflow. This means that the current 
Light Source settings will be used for all clips you scan until you manually change those settings 
again, even for clips that you’ve logged from different parts of a film roll. This means that the log 
and capture style of working is only advisable in situations where it makes sense to log multiple 
clips that share the same Master Offset and RGB Offset adjustments. 

Otherwise, it’s recommended you make lighting adjustments on a clip-by-clip basis, as you 
scan each clip, in situations where you need maximum image quality for finishing. Keep in mind 
that the goal for these adjustments is to maximize image data from the scan, not to create the 
final look of the clips, which you’ll accomplish later in the grading phase of work using the 
controls of the Color page.

To adjust the Light Source settings, find a typical image for the section of roll or for the first 
series of shots you’re going to scan, and adjust the light source while viewing the built-in 
video scopes. 
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Adjust Master Offset to set the intensity of the light source used to illuminate the film, raising or 
lowering the level of the R, G, and B channels all at once. For typical camera negative, this lets 
you adjust the black point of the film image (the darkest part of the image, which in fact 
corresponds to the highlights of the film image) to sit just above the typical Dmin value of 95, as 
measured on the Histogram of the video scopes, which guarantees that the highlights won’t be 
clipped by the Cineon LOG conversion that DaVinci Resolve uses to debayer the CRI image for 
grading. For positive film, simply adjust Master offset so that no part of the highlights or 
shadows of the signal is being clipped. 

TIP: You can turn on Show Reference Levels in the Waveform, RGB Parade, or 
Histogram scopes, and set the Low value to indicate the digital Dmin value of 95.

Once that’s accomplished, adjust the RGB Offset controls to rebalance all three color channels 
by varying amounts to alter the color temperature of the light source used to illuminate the film, 
to produce the most useful (typically neutral) color balance in the scanned result.

Scanning One or More Sections of Film
After you’ve adjusted the Light Source, it’s a good idea to stay organized as you scan each clip 
by entering all relevant metadata into the Metadata Editor as you go. The Capture group of 
metadata fields contains information for defining the File Name Prefix, Roll, Reel Number, Clip 
Number, Program Name, Flags, and whether a particular take is good. If you populate these 
fields before scanning a clip, that metadata will be written into the clip.

With all of this accomplished, you can scan clips from film in one of three ways:

 � Capture Now: Clicking Capture Now begins scanning near the current frame, ending 
whenever you click Stop Capture. Using Capture now, you can capture long sections of 
a roll all at once. 

 � Capture Clip: A more controlled means of scanning specific sections of film. After 
you’ve used the Transport controls and the In and Out button to define a section of film, 
clicking Capture Clip scans that one clip and then stops.

 � Batch Clips: A way you can log multiple clips in advance of scanning them all at once 
using the current Light Source settings in the Cintel panel. Log each clip in advance by 
setting In and Out points for each section of film you want to scan, and click the Log 
Clip button to save that frame range as an unscanned clip in the Media Pool. When you 
click Batch Clips, all unscanned clips will be scanned one after the other until the job is 
complete. You can also select one or more unscanned clips, and only the selected clips 
will be scanned. Furthermore, you can import an EDL that corresponds to a particular 
film roll, and use the resulting logged clips for scanning.

For more information on Batch Capture workflows, see Chapter 16, “Ingesting From Tape.”
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Extracting Audio
If the film you’re scanning also contains an optical sound track, you can extract the audio in a 
separate step. There is a standard image frame to audio frame offset of 26 frames for 16mm and 
21 frames for 35mm that DaVinci Resolve automatically aligns when extracting the audio. Select 
all of the clips that have an optical sound track, then right-click one of the selected clips and 
choose Extract Audio. DaVinci Resolve analyzes the overlapping optical track area of each 
frame and automatically generates a matching audio track, synchronized with the scanned 
image sequence. Each clip’s audio will be automatically extracted, embedded in the clip, and 
saved to the same directory the scanned frames have been written to.

Each clip’s audio will be automatically extracted, embedded in the clip, and saved to the same 
directory the scanned frames have been written to. A small audio icon will appear on the corner 
of your clip’s thumbnail so you know there is a corresponding audio file.

To make extraction easier, you can filter the clips in the media storage by name, resolution, date 
modified, or by film clips only. Filtering your clips makes it easier for you to find and select 
exactly what you need. You can also make a large selection and extract audio from multiple 
clips at once by right-clicking on your selection and choosing Extract Audio from the 
contextual menu.

You can filter the contents in the media storage to make it easier to manage them

During audio extraction, an information box will appear to indicate the progress. You can stop 
the extraction at any time by clicking on the Stop button

NOTE: If the Timestamp Prefix checkbox was deselected in the Capture Info section 
when your clips were scanned, and you want to have extracted audio automatically 
embedded in your clips, always remember to extract audio from the clips inside the 
Media Pool.
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Audio Extraction Settings
Normally, once you have selected the film type, the automatic features in DaVinci Resolve will 
extract your optical audio perfectly. However, the condition of the optical track can vary with 
the condition of the film being loaded and in some instances this can confuse the automation. If 
this happens, you can bypass the automatic features and make adjustments manually.

For manual adjustments, open the Audio Extraction settings window by clicking 
Show Cintel Audio Settings in the Inspector options near the top right of the Viewer

Audio extraction settings let you make the following manual adjustments:

 � Show audio scan area: This checkbox turns the audio scan area guides on or off. The 
guides are displayed as a box on the side of the frame covering the optical audio scan 
area and show what optical information will be used during extraction. The position of 
the guides will conform to the film type you have selected; however, you can change 
the position manually if you need to. The audio scan area guides are also great 
indicators to show you what is happening during the extraction process so you can 
identify any potential troubles and make manual adjustments.

Inside the box is a thin red line. This line is the mid point detector which detects the 
separation between stereo audio channels. When mono sound is detected during 
audio extraction, the mid point detector disappears and the guides will adjust 
automatically to suit the width of the mono optical track.

TIP: If you need a closer inspection of the audio scan area guides, you can 
zoom into the Viewer and move the Viewer position up or down, and left or 
right. Simply choose the amount of zoom from the sizing options at the top left 
corner of the Viewer, then click and drag the Viewer with your mouse or 
track pad.
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When Show Audio Scan Area is turned on, the audio area guides will be visible so you 
can see exactly what information is being used and monitor the extraction process

 � Override audio scan area: This setting provides sliders for adjusting the horizontal and 
vertical positioning, width, and height of the audio scan area guides. These settings 
include:

 – Left and Width: If your film type is such that audio appears on the right side of 
the frame, you can simply adjust the Left slider to move the guide box to the right. 
Normally, this will happen automatically if you have the corresponding film type 
selected, but the setting gives you more flexibility for adjustments if you need it. 
Similarly, the Width setting is used to adjust the width of the scan area.

These are helpful tools for making subtle adjustments to the side edges of the guide 
box if there are unwanted elements inside the film’s optical audio area. This can 
happen due to perforation wear and tear, or varying print qualities, and can 
sometimes interfere with the quality of the audio extraction. You can help avoid this 
by making a subtle movement to the side edges to keep the stray elements outside 
of the guide box.

 – Top: Adjusts the vertical position of the guide box.

 – Height: Sometimes film frames on older rolls of film may be slightly smaller than 
normal due to shrinkage over time. When making manual adjustments to the guide 
box, you can make adjustments for film shrinkage using the Height slider.

 � Auto adjust audio scan height: This setting is on by default and automatically adjusts 
the guide box height to align with the audio waveform at the top of each frame. The 
automatic feature works well for normal audio conditions; however, if during extraction 
you notice the box moving randomly and the quality of the extraction is affected, it may 
be due to similar features in the audio track overlapping between frames. If this occurs, 
deselect the checkbox and try the extraction again.

TIP: If deselecting the Auto Adjust Audio Scan Height checkbox, make sure 
the Height setting places the guide box at the optimal position for the frame. 
Making manual adjustments can help if you need them, but don’t forget to turn 
the automatic features back on afterwards.
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 � Audio waveform color is white: Depending on the scanned film type, the audio 
waveform may be black or white. If the waveform is white, make sure the corresponding 
checkbox is enabled. This will ensure the white information in the waveform is used 
during audio extraction. If the waveform is black and the surrounding audio area is 
white, disable the checkbox so DaVinci Resolve knows to use the black information in 
the waveform. Other automatic features, such as mid point and mono detection, also 
rely on this setting being set correctly.

 � Override firmware stability: In rare instances, the condition of the film may have 
created large movements in the frame due to the internal firmware stabilization. This 
can cause the audio extraction guide box to misalign with the optical track. If this 
occurs, enabling “Override Firmware Stability” lets the audio extraction guide box to 
track the film perforations independently and adjust its positioning for potentially better 
results.

 � Variable density audio: If your film contains variable density audio, make sure you 
select the Variable Density Audio checkbox so DaVinci Resolve knows the type of 
audio to extract. The default state is set to Off for variable area audio soundtracks.

TIP:  If you haven’t used variable density audio before, you can visually identify 
it as a tight sequence of shaded lines, similar to a bar code with the lines 
squeezed closer together. By comparison, Variable Area soundtracks appear 
as an audio waveform.

Grading and Sizing Scanned Media
A pair of 1D LUTs, “Cintel Negative to Linear,” and “Cintel Print to Linear,” have been provided to 
help you convert scanned media to a color space in which you can do further work. You can 
apply these LUTs via a node in the Color page to convert the original scans to a Linear color 
space. However, if you want to convert the image to Rec. 709 or to Cineon for further 
adjustment, you’ll want to apply a second LUT in a second node.  In general for Negative film, 
it’s best to “color invert” after the second LUT is applied so you can then apply grade 
operations on the Linear data. There are a variety of VFX IO LUTs available in the 3D LUT 
submenu of each node’s contextual menu that let you convert an image from Linear color space 
to any other color space you want to work within. For more information, see Chapter 50, 
“Working in the Node Editor.”

Using three nodes to convert a film scan using LUTs, node 1 converts from Negative or Print to Linear, 
node 2 converts from Linear to Rec. 709, and node 3, if required, inverts the color
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NOTE: Applying a LUT within a node will clip any image data falling below 0 and above 
1. To correct for this, you can use the Lift/Gamma/Gain controls within any node with a 
LUT applied to adjust your image levels prior to the transform applied by the LUT 
within that node.

Depending on the format you’re scanning and the way the material was shot, you may need to 
also resize the resulting scans, resizing, zooming, stretching, panning, and tilting to create the 
final framing you require. You can use the Input Sizing mode of the Sizing palette in the Color 
page to create the necessary framing, and save a sizing preset (by clicking the Create button 
and entering a name in the resulting dialog). Once you’ve created an appropriate sizing preset 
for a given type of media, you can apply that preset to multiple film scans all at once, in either 
the Color page or in the Media Pool using the Change Input Sizing Preset command, found in 
the contextual menu of selected clips. For more information on sizing in DaVinci Resolve, see 
Chapter 119, “Sizing and Image Stabilization.”

Creating a sizing preset in the Sizing palette of the Color page
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